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Chapter 0 About This User’s Guide

WARNING! Do not attempt to use this analyzer without first reading and 
understanding the entire User’s Guide! 

Unpacking and
Assembling Your
Niton XLp XRF

Analyzer

• Inspect the shipping carton for signs of damage such as crushed or water 
damaged packaging. Immediately notify the shipping company and 
Thermo Scientific, in the United States, toll free, at (800) 875-1578, or 
outside the United States, at +1-978-670-7460, if there is any visible 
damage to the shipping container or any of its contents. 

• Open the packing carton. If your analyzer is not packed in its carrying 
case, please call Thermo Scientific immediately, in the United States, toll 
free, at (800) 875-1578, or outside the United States, at 
+1-978-670-7460.

• Verify the contents of the shipping container against the enclosed 
packing list. If there are any discrepancies between the actual contents of 
the shipping container and the enclosed packing list, please notify 
Thermo Scientific immediately, in the United States, toll free, at (800) 
875-1578, or outside the United States, at +1-978-670-7460.

• Open the carrying case and visually inspect the analyzer for damage 
before removing it from the case. Call the shipper and Thermo 
Scientific if you find any damage to the case or its contents.

• Save the shipping carton and all packing materials. Store them in a safe, 
dry area for reuse the next time that you ship the analyzer. 
Thermo Scientific NITON XLp Analyzer User’s Guide 0-i



About This User’s Guide
The Niton XLp XRF
Analyzer Overview

The Niton XLp Analyzer is a single unit, hand held, high performance 
portable x-ray fluorescence (XRF) elemental analyzer.

Figure 0-1. Analyzer Overview

The Control Panel The control panel is located on the analyzer’s top housing, directly below the 
LCD touch screen (see Figure 0-1). The control panel consists of a 4 way 
touch pad and two control buttons, one on each side. Using either the 
control panel or the touch screen (with or without the Niton standard touch 
screen stylus accessory that clips in the XLp battery pack) you may navigate 
through all of the analyzer’s screens and menus. You can control the 
movement of the screen cursor by pressing the four way control pad in one 
of four directions to highlight each of the menu options. The enter button 
on the right side of the four way touch pad is used to select highlighted 
menu options. The on/off/escape button both controls the power to the 
analyzer and serves as an "escape" button. When the on/off/escape button is 
pushed and immediately released, it functions as an "escape", and brings 
you back to the Main Menu from the current screen in the menu system.
ii NITON XLp Analyzer User’s Guide Thermo Scientific



About This User’s Guide
Figure 0-2. The Control Panel

Push and hold the on/off/escape button for at least 3 seconds to turn the 
analyzer on. A 'beep' will sound as the power comes on. Push the 
on/off/escape button and hold it down for about 10 seconds to shut off 
power to the analyzer from any screen in the menu system. The analyzer will 
'beep' as it shuts down.

You also have the option of operating the analyzer, including navigating the 
menu system, by using the built in touch screen with or without the stylus. 
To select a menu option with the stylus, tap on the icon once. The touch 
screen icons have the same functionality as the four way touch pad, the 
on/off/escape button, and the enter button. This User's Guide will refer to 
the process of choosing a course of action by selecting an icon from a menu, 
either using the touch screen or using the control panel buttons, as 
“selecting.”

Selecting the Return icon works everywhere throughout the User Interface 
to bring you back to the previous menu from the current menu in the menu 
system. Use the on/off/escape button to return to the Main Menu. 
Thermo Scientific NITON XLp Analyzer User’s Guide iii
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Instrument Startup To turn on the analyzer, depress the on/off/escape button on the control 
panel for approximately 3 seconds, until you hear a beep. 

Figure 0-3. System Start Screen

On startup, the screen will be replaced by a Restart screen (see Figure 0-3) 
which will automatically count down from 9 to 0 in increments of one 
second. 

Figure 0-4. Logon Screen

When the Restart is complete, the Restart Screen will be replaced by the 
Logon screen (see Figure 0-4.) Tap anywhere on this screen to continue.
iv NITON XLp Analyzer User’s Guide Thermo Scientific



About This User’s Guide
The Logon Screen will be replaced by a Warning Screen, advising you 
that this analyzer produces radiation when the lights are flashing. You must 
acknowledge this warning by selecting the “Yes” button before logging on. 
Selecting the “No” button will return you to the Logon Screen.

Figure 0-5. Warning Screen
Thermo Scientific NITON XLp Analyzer User’s Guide v



About This User’s Guide
After selecting the “Yes” button, the Virtual Numeric Keypad becomes 
available for you to log onto the analyzer.

Figure 0-6. Virtual Numeric Keypad for Logon

Select your 4 digit security code, followed by the enter (E) key. The 
temporary password assigned by default is 1-2-3-4, followed by the “E” key. 
After you have completed the log on procedure, the word "USER" will 
appear on the bottom of the screen, then the Main Menu will appear. Note 
that security codes are editable. Please see the NDT manual for instructions 
on creating user-definable passwords.

Check the date/time. The time should be set correctly for accurate and 
verifiable record keeping (see Set Time and Date on page 2-9). 

Your analyzer can be stored safely in temperatures of up to 122ºF (50ºC) 
and is designed to operate at temperatures of up to 122ºF (50ºC). You will 
not be able to take a measurement if the analyzer overheats. If it is hot to the 
touch, you should allow it to cool before testing.

Screen Contrast To adjust the contrast of your analyzer’s touch screen display, press and hold 
the left and right ends of the 4 way Touch Pad until a beep sounds. After the 
beep, you may press the up portion of the 4 way Touch Pad to darken the 
screen, and the down portion to lighten the screen. When you have the 
display adjusted so that it is best for you, press the “Enter” button to save 
the current setting. 
vi NITON XLp Analyzer User’s Guide Thermo Scientific



Chapter 1 Radiation Safety

CAUTION NITON Analyzers are not intrinsically safe analyzers in regard 
to sparking. All pertinent Hot Work procedures should be followed in areas 
of concern. 

The NITON XLp Analyzer was designed so that virtually no measurable 
radiation external to any part of the instrument can escape when the shutter 
is closed. When the instrument is used in accordance with it's instructions, 
it is completely safe, that is, there is minimal radiation exposure, even with 
the shutter open.

NITON XLp Analyzers contain sealed 109Cd and/or 55Fe and/or 241Am 
radioactive isotope sources. The source is designed to remain secure even 
under extreme conditions, so that even if the instrument is broken, crushed 
or burned, there should be no leakage of radioactive material.

During manufacturing, each sealed isotope source is locked in place in a 
solid tungsten alloy source holder. The source is completely secure in its 
housing because the aperture at the closure end of the housing is smaller 
than the source and is completely sealed. The source assembly is secured in 
the instrument’s case, which is fitted with tamper-proof screws.

Human exposure to radiation is typically measured in REMs, or in 
one-thousandths of a REM, called milliREMs (mREM). For a given source 
of radiation, three factors will determine the radiation dosage you receive 
from the source: 

1. Duration of Exposure

The longer you are exposed to a source of radiation the more radiation 
strikes your body and the greater the dose you receive. Dosage increases 
in direct proportion to length of exposure.

2. Distance from The Source

The closer you are to a source of radiation, the more radiation strikes 
you. The dosage increases in inverse-squared relation to your distance 
from the source of radiation. For example, the radiation dose one inch 
from a source is nine times greater than the dose three inches from the 
Thermo Scientific NITON XLp Analyzer User’s Guide 1
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source, and 144 times greater than the dose one foot (12 inches) from 
the source. For another example, the radiation dose one meter from the 
source of radiation is 100 times lower than the dose at 10 cm from the 
source of radiation. Keep your hand and all body parts away from the 
front end of the analyzer when the shutter is open to minimize your 
exposure. 
2 NITON XLp Analyzer User’s Guide Thermo Scientific
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3. Shielding

Note Your instrument emits virtually no radiation with the shutter closed 
because the 109Cd and/or 55Fe and/or 241Am sources are thoroughly shielded in 
every direction. This shielding absorbs nearly all of the radiation produced 
by the source – except when the shutter is open during testing. With the 
shutter open, the instrument emits a maximum directed radiation beam of 
approximately 315 mREM/hr intensity. Always hold your instrument so 
that the radiation beam is not aimed at yourself or at anyone else. Supplied 
or optional test stands add shielding for analysis.Wearing a dosimeter badge 
does not protect you against radiation exposure. A dosimeter badge 
measures your exposure. 

Note Pregnant workers may want to take special precautions to reduce their 
exposure to radiation. Qualified scientists have recommended that the 
radiation dose to pregnant women should not exceed a total of 500 
mREM/gestation period. See U.S. NRC Regulatory Guide 8.13 
"Instruction Concerning Prenatal Radiation Exposure". 

Table 1-1 lists typical radiation doses encountered in daily life and lists the 
annual occupational radiation dosage limits for adults set forth in 105CMR 
120.200.

Table 1-1. Typical Radiation Dosages (NCRP, 1987)

Category Dose in mREMs Dose in mSv

Average total dose 
in US (annual)

360 mREM (3.6 mSv)

Average worker 
exposure (annual)

210 mREM (2.1 mSv)

Average exposure 
for underground 
miner (annual)

400 mREM (4.0 mSv)

Exposure for 
airline crew (1,000 
hours at 35,000 ft)

500 mREM (5.0 mSv)

Additional from 
living in Denver at 
5300' (annual)

25 mREM (0.25 mSv)

Additional from 4 
pCi/l radon in 
home (annual)

1,000 mREM (10.0 mSv)

Typical chest x-ray 6 mREM (0.06 mSv)
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As noted above, the allowable limit in the U.S. for occupational exposure is 
5,000 mREM/year (50 mSv/year) for a whole-body and 50,000 mREM 
(500 mSv) for shallow penetration of extremities. Extremity exposure from a 
properly used NITON XRF analyzer will be less than 100 mREM per year, 
(1.0 mSv per year) even if the analyzer is used as much as 2,000 hours per 
year, with the shutter open continuously.

Typical head or 
neck x-ray

20 mREM (0.2 mSv)

Typical pelvis/hip 
x-ray

65 mREM (0.65 mSv)

Typical lumbar 
spine x-ray

30 mREM (1.3 mSv)

Typical upper G.I. 
x-ray

245 mREM (2.45 mSv)

Typical barium 
enema x-ray

405 mREM (4.05 mSv)

Typical CAT scan 110 mREM (1.10 mSv)

Minimum 
detectable dose on 
a standard film 
badge

5 mREM/QTR (0.05 mSv)

Annual occupational dosage limits:

Maximum 
allowable for the 
general public 
(annual)

100 mREM (1.0 mSv)

Annual Occupational Dose Limits for Adults:

Whole body 5,000 mREM/yr (50 mSv)

For a pregnant 
worker (during 
gestation period)

500 mREM (5.0 mSv)

For a minor 500 mREM (5.0 mSv)

Eye dose 
equivalent

15,000 mREM (150 mSv)

Shallow dose 
equivalent to the 
skin or any 
extremity or organ

50,000 mREM (500 mSv)

Table 1-1. Typical Radiation Dosages (NCRP, 1987)

Category Dose in mREMs Dose in mSv
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Note NCRP is the National Council on Radiation Protection and 
Measurements. 
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How to Use Your NITON XLp
HOW TO USE YOUR
NITON XLp

The NITON XLp was designed to be as safe as possible. However, we 
strongly recommend that you follow these precautions to insure your safety 
and the safety of those around you.

WARNING! Always be aware of the location of your instrument’s 
radioactive sources and the direction of their beam of X-rays. The location 
of the sources is at the front end of the instrument. 

Note Open the shutter only to analyze a sample. The shutter can only be 
opened after the user has logged on to the analyzer using the password. 

During testing, a strong beam of radiation is continuously emitted through 
the kapton window at the front of the analyzer (see Figure 1-1). There will 
be some radiation at the front and top-front of the analyzer. There is 
negligible radiation at the handle of the analyzer. 

Figure 1-1. Direction of x-ray beams.

WARNING! Always treat radiation with respect. Do not hold your 
analyzer near the Kapton Measurement Window during testing. Never 
point your analyzer at yourself or anyone else when the shutter is open. 
6 NITON XLp Analyzer User’s Guide Thermo Scientific
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How to Use Your NITON XLp
SHUTTER SAFETY Note Under no circumstances should the shutters be open when the 
instrument is not in use! 

The 3 warning lights on your instrument will go on when one of the 
shutters is open and stay on as long as one of the shutters remains open. 

WARNING! In the unlikely event that the shutter becomes stuck in the 
open position, remove the battery (see Battery Pack and Battery Charger - 
Routine Maintenance Guidelines - Note: All shutters should close 
immediately and remain locked in the closed position when the battery pack 
is not attached to the instrument), replace the instrument in its shielded 
holster, place the holster in the shielded carrying case, and call Thermo 
Scientific’s Service Department at (800) 875-1578 or +1-978-670-7460. 

WARNING! If your LCD Touch Screen displays the message ”SHUTTER 
DOES NOT OPERATE”, remove the battery (see Battery Pack and Battery 
Charger - Routine Maintenance Guidelines - Note: All shutters should close 
immediately and remain locked in the closed position when the battery pack 
is not attached to the instrument), replace the instrument in its shielded 
holster, place the holster in the shielded carrying case, and call Thermo 
Scientific’s Service Department at (800) 875-1578 or +1-978-670-7460. 
Thermo Scientific NITON XLp Analyzer User’s Guide 7
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Monitoring your Radiation Exposure
Monitoring your
Radiation Exposure

There is virtually no measurable radiation from a NITON XLp analyzer 
when its shutters are closed. The maximum dosage to which you are 
exposed when properly operating your NITON XLp is <0.1 mREM/hr on 
the fingers of the hand holding the instrument, with the shutters open.

 As an additional precaution to ensure that your radiation exposure is always 
minimal, NITON recommends that you determine and follow your state or 
country’s specific regulations concerning radiation monitoring. A dosimeter 
badge is usually worn close to the parts of your body that are most sensitive 
to radiation, including your reproductive organs and your eyes. These 
badges are available from many companies. Two companies offering 
dosimeters in the USA are:

Landauer, Inc.

2 Science Road

Glenwood, IL 60425-9979.

Proxtronics

5795-B Burke Centre Highway

Burke, VA 22015

These companies are listed for information purposes only. NITON does not 
endorse the services of these companies.

NITON recommends you ask your radiation dosimeter badge supplier for a 
quarterly schedule. Monthly schedules are also available.

Leak Tests
The radioisotope source shielding on your NITON XLp analyzer is 
designed to hold up even under extreme conditions, including the 
instrument being crushed or burned. The continued effectiveness of the 
instrument’s radiation shielding should be tested every six months by 
performing a thorough leak test. 

In the USA, this is a regulatory requirement: Thermo Scientific’s license 
requires that leak tests be repeated once every six months. Leak test kits, 
which include complete instructions for performing the test, are available 
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Monitoring your Radiation Exposure
from several vendors. These vendors typically remind you when it is time to 
perform the next leak test on your instrument. Please follow the test kit 
instructions carefully, and promptly mail the test samples to the laboratory. 

The diagram in Figure 1-2 shows the test wipe locations. 

All source shutters must be closed while performing a leak test!

Figure 1-2. Locations of seams for leak testing
Thermo Scientific NITON XLp Analyzer User’s Guide 9
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Monitoring your Radiation Exposure
The following laboratories supply leak test kits:

Applied Health Physics

2986 Industrial Blvd.

Bethel Park, PA 15102

Tel: (412) 835-9555

Stan A. Huber Consultants

200 N. Cedar Road

New Lennox, IL 60451

Tel: (800) 383-0468

Valley Safety Services

330 Old Enfield Road

Belchertown, MA 01007

Tel: (413) 323-9571 

Please check with your local NITON representative if you are located 
outside the USA
10 NITON XLp Analyzer User’s Guide Thermo Scientific
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Procedures for
Analyzer Loss or

Damage

IN THE USA If your analyzer is damaged, destroyed, lost, or stolen, call:

The Office of Radiological Safety for your state’s Dept. of Health.

Telephone:___________________________________

OUTSIDE THE USA If your analyzer is damaged, destroyed, lost, or stolen, call:

The proper authorities for your location.

Telephone:___________________________________

Also, notify the NITON Analyzer service department using one of the 
numbers below:

During Regular Business
Hours

Calling from within the USA - (800) 875-1578 (toll-free)

Calling from outside the USA - +1-978-670-7460

During Evenings and
Weekends, From Anywhere

CALL ONLY WHEN YOU HAVE A RADIOLOGICAL EMERGENCY

• Ken Martin - Mobile Phone Number - +1 (617) 901-3125

• Jim Blute - Mobile Phone Number - +1 (978) 790-8269

If your analyzer is lost, stolen, or damaged in a car accident, also, 
immediately notify your State Police Department: 

Telephone: ___________________________________

If your instrument is damaged in a fire or an explosion, also 
immediately, notify your local Fire Department.

Telephone:___________________________________

Note Please fill in the phone numbers on these pages today. Keep copies 
where you can find them in case of an emergency. 
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XLp Radiation Dose
Profile - Wood

Substrate

Figure 1-3. XLp 300 series radiation profile

Note Not to scale. 

Note Profile conducted by: James Blute, CHP, Corporate RSO, 04/05/04. 

Note Substrate 3/4” thick pine. 

Note Profile was taken with the strongest source and the least dense 
substrate to show the worst case scenario. Any other combination of source 
strength and substrate would result in lower dose rates from scatter 
radiation. 

Table 2: XLp 300A/700A Series In-Beam Dose Rates - Shutter Open

Isotope Activity 5 cm 30cm 100 cm Trigger

Cd-109 50 369 14.8 1.71 0.053
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XLp Radiation Dose Profile - Wood Substrate
Figure 1-4. View of the Underside of the XLp Analyzer Showing 
Proper Placement of General and State Specific Radiation 
Labels
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XLp Radiation Dose Profile - Wood Substrate
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Chapter 2 The Menu System

The Niton XLp Menu System enables you to perform critical tasks, 
including taking readings and viewing data, with a minimum number of 
steps. Menus are presented as small pictures called icons which, when 
selected, will do one of three things:

• Toggle between two different functions or views, such as turning 
backlighting on or off.

• Present a subsidiary or sub-menu which will allow you access to more 
choices.

• Present a screen which allows you to view data, change settings, or 
control the analyzer.

Icons which appear on your Niton analyzer screen display in dark gray 
(grayed out) represent features which are not enabled, and therefore cannot 
be selected. In order to enable features on your Niton analyzer which are 
currently not enabled, please contact Thermo Scientific in the United 
States, toll free, at (800) 875-1578, or outside the United States, at 
+1-978-670-7460, or your local Authorized Niton Analyzer Service Center. 

Icons which appear on your Niton analyzer screen display with a diagonal 
line through them represent features which are currently turned off. When 
an icon with a diagonal line through it is selected, the diagonal line through 
that icon will automatically be erased, and the feature corresponding to that 
icon will become enabled.
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The Menu System
The NAV Menu
The NAV Menu

Figure 2-1. The NAV Menu

The Navigation Menu, or NAV Menu, is available in all screens, though 
only through the touch screen interface. Within a menu, the particular 
options available from the NAV Menu may change with the context. For 
example, within the View Menu, the NAV Menu changes options 
depending on the mode you are currently using.

Access the NAV Menu by selecting the word NAV in the screen. A 
drop-down menu of choices will appear. Selecting an option from the NAV 
Menu will take you directly to a particular menu, no matter where you are 
in the menu hierarchy. Selecting the “View” option from the NAV Menu, 
for example, will bring you directly to the Data Menu.

Selecting the “Language” option will load the Language Screen, 
allowing you to change the language from the default English to French, 
Spanish, Portuguese, or German.
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The NAV Menu
Figure 2-2. The Language Setting Screen

Select the language you want from the Nav Menu. 

Figure 2-3. The Main Menu in Spanish

The NAV Menu cannot be selected through the Control Panel.
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The Menu System
The Battery Life Indicator
The Battery Life
Indicator

The Battery Life Indicator is visible on all screens in the menu system. The 
indicator is visible in the top right portion of the screen, and graphically 
shows you how much battery life is left, enabling you to change batteries as 
needed to avoid unexpected shutdowns.

Figure 2-4. Battery Life Indicator

The more black visible in the indicator, the higher the charge. The more 
white visible in the indicator, the lower the charge. It’s best to charge one 
battery while using the other, to avoid work slowdowns or stoppages due to 
battery charge conditions.

Battery Life Indicator

Key

Battery almost 
empty

Battery at partial 
charge

charge
Battery at full
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The Main Menu
The Main Menu

Figure 2-5. The Main Menu

All Niton XLp analyzers functions are accessible from the Main Menu and 
subsidiary menus. Each of the analyzer’s functions represented by an icon on 
the Main Menu screen (Test, Mode, Utilities, Data, and Common Setup) 
may be selected by choosing the appropriate icon. When one of these Main 
Menu icons is selected, the function specific sub-menu appropriate to that 
icon will be displayed.

In order to test samples in the previously used test mode, simply select the 
Test icon. Your Niton XLp analyzer will operate in the testing mode that is 
currently selected. Choose an appropriate test mode for the samples you are 
testing by selecting a mode from the Mode Menu. 

Access the Mode Menu by selecting the Mode icon from the Main Menu 
screen. The analyzer will remember the last mode used on the analyzer, and 
will use that mode by default unless another mode is selected.

Access the Utilities Menu by selecting the Utilities icon from the Main 
Menu screen. The Utilities Menu enables you to view analyzer 
specifications; set the date and time; and auto-calibrate the analyzer 
electronics and the touch screen display.

Access the Data Menu by selecting the Data icon from the Main Menu 
screen. The Data Menu allows you to view readings, and allows you to view 
the alloy library and stored signatures.
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The Main Menu
Access the Common Setup Menu by selecting the Common Setup icon 
from the Main Menu screen. The Common Setup Menu allows you to 
turn on or off the liquid crystal display backlight, turn on or off the 
integrated bar code scan engine, to enable and configure source utilization, 
and to enable or disable the printer.

Return to the Logon screen by selecting the Logoff icon. The Logon 
Screen logs you out and allows you to login again, preventing casual 
unauthorized access to your analyzer.
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The Mode Menu
The Mode Menu

Figure 2-6. The Mode Menu

The Mode Menu enables you to select any one of the sample test modes 
that have been installed on your Niton XLp analyzer.

Select the Alloy icon to access any one of the alloy testing modes. The Alloy 
Modes enable you to test metal alloys for chemical composition and/or alloy 
identification. The Alloy Testing Modes are detailed in Chapter 3 of this 
User's Guide.

Select the Bulk Sample Mode icon to access Bulk Sample Mode. The 
Bulk Sample Mode allows you to analyze plastics, electronics, soil, mining, 
and other thick samples for metallic composition and/or contamination. 
The Bulk Sample Mode is detailed in Chapter 6 of this User’s Guide.

The Pb Paint Mode allows you to determine lead (Pb) loading in paint 
samples in units of mg/cm2, and to determine if paint samples are above or 
below the user-defined action level for lead in the shortest time possible. 
The Pb Paint Mode is detailed in Chapter 4 of this User’s Guide.

Select the Thin Sample Mode icon to access the Thin Sample Mode 
Menu, where you may choose a thin sample testing mode appropriate to the 
samples you will be testing. The Thin Sample Testing Modes allow you to 
analyze thin samples, such as dust wipes and air filters, and coatings for 
elemental analysis. The Thin Sample Test Modes are detailed in Chapter 5 
of this User's Guide.
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The Mode Menu
Select the User Definable Mode icon to access User Definable Mode. 
The User Definable Mode allows you to create your own protocols and 
methods for your own use. The User Definable Mode is detailed in Chapter 
7 of this User’s Guide.
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The Utilities Menu
The Utilities Menu

Figure 2-7. The Utilities Menu

To access the Utilities Menu, select the Utilities icon from the Main 
Menu display. The Utilities Menu enables you to view your Niton analyzer 
specifications, set the date and time, auto-calibrate your Niton analyzer's 
detector or touch screen display, Rotate the display on the LCD screen, or 
change the communication (baud) rate for the RS-232 port.

Select the Calibrate icon to access the Calibrate Menu. The Calibrate 
Menu allows you to calibrate the detector or to calibrate the touch screen 
interface.

Select the Specs icon to display the analyzer's specifications. These 
specifications include your Niton XLp's serial number, software and 
firmware versions, temperature, bias, and data coprocessors. Press the Close 
button to return to the Utilities Menu.

Select the Date & Time icon to set the date and time as needed for different 
time zones, daylight savings time, or any other reason. The date and time 
are factory preset prior to shipping. The format used is month/day/year - 
MM/DD/YY, and hour/minute - HH/MM, for the 24 hour clock. 
Thermo Scientific NITON XLp Analyzer User’s Guide 9



The Menu System
The Utilities Menu
Figure 2-8. Setting the Date & Time

When the Date & Time icon is selected, the Date & Time Screen comes 
up on your XLp's LCD Screen. Initially, the first character of the month is 
highlighted in reverse video (white on black), as in the sample display shown 
here. To change a character, select the digit you want to replace the character 
with from the virtual numeric keypad displayed on the screen, then select 
the Enter (Ent) character from the virtual numeric keypad. Your Niton XLp 
will then accept the entry and automatically advance to the next digit. To 
skip a character, simply select the Enter (Ent) character from the virtual 
numeric keypad without selecting a replacement character. 

For example, on the sample display, if you wish to change the "06" of the 
month to "07", the display appears with the first character (0) highlighted. 
Select the Enter (Ent) character to skip the zero. The "6" will now be 
highlighted. Select the "7" digit from the virtual numeric keypad, then 
select the Enter (Ent) key from the virtual numeric keypad. The change is 
accepted and the next digit is highlighted. Continue to select the Enter 
(Ent) symbol from the virtual numeric keypad to skip over the remaining 
characters of the date and time until the last character is reached. When you 
select the Enter (Ent) key from the virtual numeric keypad to confirm the 
last character, the word "SUCCESS" will appear beneath the Time field, 
and you will be returned to the Main Menu. The date is given in 
month/day/year format.

Numeric 
keypad

Highlighted 
numeral
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CAUTION Your XLp analyzer must have the correct time and date set in 
order to test samples correctly using the 109Cd radioisotope source. Please 
make sure that the time and date are set correctly before testing. 

WARNING! It is important that the date and time information displayed 
on the Date and Time Screen is correct. If either the date or time is 
incorrect, the information stored with your readings will be incorrect. In 
addition, an incorrect date prevents the instrument from properly 
compensating for normal source decay - causing erroneous analysis results 
for instruments equipped with 109Cd. This information must be correct 
before proceeding with testing. 

Note The analyzer will automatically return you to the Main Menu when 
the entry is complete. 

Select the Baud Rate icon to change the communications rate for the 
RS-232 port. Selecting the Change Baud Rate icon will toggle the 
communications rate between 115 kbaud and 38 kbaud. The default 115 
kbaud rate may be too fast for some older computers, and dropping the rate 
to 38 kbaud will insure proper communications between your PC and your 
Niton XLp Analyzer.

Select the Rotate Screen 180 icon to toggle the orientation of the screen 
between right side up and upside down.

This is used primarily when your analyzer is placed in the NITON 
Environmental Test Stand, because the analyzer is inverted when properly 
installed in the Test Stand.
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The Data Menu
The Data Menu

Figure 2-9. The Data Menu - First Page

To access the Data Menu, select the Data icon from the Main Menu 
display. The Data Menu enables you to access readings and libraries, for 
viewing or manipulation.

Select the View Data icon in order to access data from readings you have 
already taken. Selecting the View Data icon will bring you to the Data 
Screen.

Select the Erase icon to access the Erase Menu. The Erase Menu allows 
you to erase your data.

CAUTION Never turn off the analyzer while data is being erased! 

WARNING! Do not attempt to take measurements while downloading 
readings! This will generate an error requiring a system reset, and may 
corrupt your stored readings, requiring all stored readings to be erased. 

Select the View Libraries icon to access the Library View Menu. The 
Library View Menu allows you to view data in the Alloy Grade Library as 
well as the Superlib and Superstds libraries.
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The Data Menu
Select the View Signatures icon to view data saved as reference sample 
signatures in Signature ID Mode. When the View Data icon is selected, the 
Results screen of your most recent test is shown on the LCD display. 

Select the More icon to access the second page of the Data Menu.
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The Data Menu - Second Page
The Data Menu -
Second Page

Figure 2-10. The Data Menu - Second Page

To access the Data Menu Second Page, select the More icon from the 
Data Menu display. The Data Menu enables you to access readings and 
libraries, for viewing or deleting.

Select the View SuperChem icon in order to view your SuperChem data. 
The View SuperChem icon allows you to view your SuperChem Mode 
data, and also allows you to delete individual readings.When the View Data 
icon is selected, the Results screen of your most recent test is shown on the 
LCD display. 

Select the View SuperPrec icon in order to view your SuperPrec data. The 
View SuperPrec icon allows you to view your SuperPrec Mode data, and 
also allows you to delete individual SuperChem standards.When the View 
Data icon is selected, the Results screen of your most recent test is shown on 
the LCD display. 
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The Data Screen
The Data Screen Use the Data Screen to view previously taken test result readings. When 
the View Data icon is selected, the Results screen of your most recent test is 
shown on the LCD display. 

Figure 2-11. The Results Screen

Using the buttons on the control panel, you may view different readings or 
additional data for individual readings.

Scrolling Down Through
the Complete Listing of

Elements Pressing the "Left" position on the 4-way touch pad of your Niton analyzer 
will display the previous reading, or if the first reading is currently displayed, 
the last reading. Pressing the "Right" position on the 4-way touch pad will 
display the next reading, or if the last reading is currently displayed, the first 
reading in memory. Niton analyzers can store between 3000 to 6000 
readings.

You can also look at the complete x-ray spectra for each reading stored in the 
analyzer's memory. 

Sorting Elements  The Sort Buttons, which double as column headings, can be used to re-sort 
the data in different ways. The Data Screen always begins as a Standard 
Sort, as you have defined it. Selecting the appropriate sort button once 
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The Data Screen
toggles the sort order to High-to-Low. Selecting the sort button again 
toggles the sort order to Low-to-High. To return to the Standard Sort, view 
a different reading and return.

Figure 2-12. Element Sorts

Element Sorts Element sorts are performed alphanumerically based on the element name.

Composition Sorts Composition sorts are performed numerically based on the percentage of 
composition.

Error Sorts Error sorts are performed based on the range of error in the reading.

Spectrum Graph For any reading result, simply use the NAV Menu to gain access to the 
reading’s spectrum graph. Selecting Spectra will show a graphed spectrum of 
this reading, called SpectraView. SpectraView can be a useful tool for rapid, 
qualitative analysis of sample chemistries. See “SpectraView” on page A-7 
for details.

Standard Sort Low-to-High Sort High-to-Low Sort
16 NITON XLp Analyzer User’s Guide Thermo Scientific



The Menu System
The Data Screen
Figure 2-13. The SpectraView Screen
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The Data Entry Screen
The Data Entry
Screen

Selecting Data Entry will access the identifying criteria for each read-
ing. In this scrolling screen, you can see the identifying criteria you input 
into the Data Entry Screen describing the conditions of the reading 
analysis sample and other data concerning the reading. The parameters 
are context sensitive - they change depending on the current mode.

Figure 2-14. Sample Setting Parameters - Alloy Mode
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The Calibrate Menu
The Calibrate Menu

Figure 2-15. The Calibrate Menu

To access the Calibrate Menu, select the Calibrate icon from the Utilities 
Menu. The Calibrate Menu enables you to calibrate your analyzer’s 
electronics.

Select the Calibrate Detector icon to begin a standard calibration of your 
analyzer’s detector. Once you select the Calibrate Detector icon, 
calibration will begin immediately. The analyzer is programmed to calibrate 
for a specific, predetermined period in order to ensure proper operation of 
your Niton XLp analyzer in the field.

CAUTION Avoid any vibration, loud noise, strong electronic fields, or 
other possible interference when your analyzer is calibrating its detector. 
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The Calibrate Menu
Figure 2-16. Detector Calibration Screen

The analyzer calibration screen will be displayed until calibration is 
complete. After the calibration has finished, the calibration results will be 
displayed. Press the on/off/escape button or the Return icon to return to 
the Main Menu. In order to insure good test results, it is essential that you 
calibrate your Niton XLp300 Series Lead-based-Paint Analyzer's detector 
daily, and if a check sample test reveals discrepancies in the reading.

Select the Calibrate Touch Screen icon to re-calibrate the analyzer's touch 
screen display. This procedure establishes the display boundaries for the 
touch screen interface. When the Calibrate Touch Screen icon is selected, 
the display will show the message: "Calibrate Touch Screen". There will be a 
small cross in the upper left-hand corner of the display. Tap on this cross 
with the stylus, and the cross will disappear and reappear in the lower 
left-hand corner of the screen. Tap on the cross again, and it will reappear in 
the lower right-hand corner of the screen. Tap on the cross again and it will 
reappear in the top right-hand corner of the screen. Tap on the cross once 
more, and you will be presented with the Calibrate Menu
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Figure 2-17. The Touch Screen Calibration Screen
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The View Libraries Menu
The View Libraries
Menu

Figure 2-18. The View Libraries Menu

To access the View Libraries Menu, select the View Libraries icon from 
the Data Menu. The View Libraries Menu enables you to view reference 
data from your analyzer’s libraries.

Select the View Grade Library icon to view your default Alloy Grade 
Library, which is set by Thermo Scientific. The entries in the Grade Library 
serve as a reference for chemistry based analysis. The library entries allow the 
analyzer to work properly “out of the box” without needing time-consuming 
pre-analysis. Please refer to the NDT User Guide for information on 
modifying the Grade Library.

Select the View SuperStds icon in order to view your SuperStds Alloy 
library. 

Select the View Additional Library icon in order to view your Additional 
Library alloys, which you may have uploaded to your Analyzer with the 
NDTl utility. If you have not uploaded an additional library, the View 
Additional Library icon will be grayed-out and the View Additional 
Library function will be unavailable.
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The Common Setup
Menu

Figure 2-19. The Common Setup Menu

To access the Common Setup Menu, select the Common Setup icon 
from the Main Menu display. The Common Setup Menu gives you access 
to various Niton XLp analyzer functions, including touch screen display 
backlighting and the built in bar code scanner, and enables you to configure 
the way the sources contained in your Niton XLp analyzer are used in 
sample testing.

Select the Instrument Setup icon to access the Instrument Setup Menu. 
The Instrument Setup Menu enables you to toggle the display backlight 
on or off, configure the Bluetooth wireless connection, configure 
trigger/proximity button use, or configure sources.

Select the Adjust Calibration icon to access the Calibration Adjustment 
Setup Screen. The Calibration Adjustment Setup Screen enables you 
to recalibrate your analyzer for more effective analysis in the various 
different modes available to you. This option is only recommended for use 
after consulting with Niton Applications

Select the Element Display Options icon to bring up the Element 
Display Menu. The Element Display Menu enables you to control the 
sorting of elements in the sample display, and the pass-fail threshold for 
sample analysis.

Select the Serial Output icon to access the Serial Output Menu. The 
Serial Output Menu allows you to adjust the parameters for downloading 
data across a serial line to a computer, printer, or other computing device.
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The Element Display
Menu

Figure 2-20. The Element Display Menu

To access the Element Display Menu, select the Element Display icon 
from the Common Setup Menu. The Element Display Menu enables 
you to control element sorting parameters and adjust elemental thresholds.

Select the Sort Element Display icon to configure sorting criteria used for 
analysis display. Selecting the Sort Element Display icon opens up the 
Sort Criteria Screen. Select the mode you wish to change, and the 
Sorting Options Screen will appear.

Figure 2-21. The Sort Element Display
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Figure 2-22. The Sorting Options Screen

On the left of the display are elements, each with its currently selected 
display option beside it to the right. The element list is ranked by 
importance, with the most important element on top, and each one lower 
down of less importance than the one above it.

By selecting an element and using the arrow buttons to the right of the list, 
you can change its ranking. Use the Top Arrow Button to move an element 
one rank closer to the top with each click. Use the Bottom Arrow Button to 
move an element one rank closer to the bottom with each click.

Element affected

Current display option
selected

Top Arrow Button

Bottom Arrow Button

Scroll bar for elements

Display Options
Radio Buttons

Save Button

Close Button

(Move up in rank)

(Move down in rank)
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.

Figure 2-23. Changed Sort Order

The Display Options Radio Buttons allow you to change the display status 
of any element to one of three states:

• Normal - The standard state. Element displays only when the elemental 
value is greater than the limit of detection.

• Always - Always display the results for this element. Use this state for 
elements critical to all of your analyses.

• Never - Never display the results for this element. Use this state for 
elements which are unimportant to your work. This makes your 
instrument display less complex.

Select the element you want to change, then select the radio button 
corresponding to your choice of display status. The currently selected 
element is displayed in white on black.
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Figure 2-24. Changed Display Options

Select the Save Button to save your current status as the new default. After 
saving, you will go back to the Element Display Menu.

Select the Close Button to exit without saving. When you select the Close 
Button after changing the display state of any element, a screen will open 
asking you if you want to save the changes you made. Selecting “Yes” will 
save these changes as the new default. Selecting “No” will return you to the 
Element Display Menu without saving the changes.
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Figure 2-25. Save Changes

Select the Set Element Threshold icon to configure pass and fail criteria 
for elemental analysis. Selecting the Set Element Threshold icon opens 
the Set Threshold Screen. 

Figure 2-26. Set Threshold Screen
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Select the mode you wish to work with from the scrollable list. This will 
open up the Pass/Fail Settings Screen for that mode.

Figure 2-27. Pass/Fail Settings Screen

Selecting the Pass Value will open up the Pass Editor for the selected 
element. 

Figure 2-28. The Pass Editor

Mode

Save Button

Close Button

Element

Pass Value

Fail Value
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The Pass Editor is very similar to the Logon Screen. The “C” button clears 
the field, and the “<“ button clears the last numeral. Select the numerals you 
want, then press “E” to enter the number. “OFF” resets the value to “OFF”

Selecting the Fail Value will open up the Fail Editor for the selected element. 

Figure 2-29. The Fail Editor

The Fail Editor works the same as the Pass Editor. 

When you press the “E” button in either editor, you are returned to the 
Pass/Fail Settings Screen, with your new values in place.

Selecting the “OFF” button not only sets the value to “OFF” but also saves 
the new value.
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Figure 2-30. ThePass-Fail Settings Screen with new parameters

Select the Save Button to save your current status as the new default. After 
saving, you will go back to the Element Display Menu. 

Select the Close Button to exit without saving. When you select the Close 
Button after changing the display state of any element, a screen will open 
asking you if you want to save the changes you made. Selecting “Yes” will 
save these changes as the new default. Selecting “No” will return you to the 
Element Display Menu without saving the changes.

Figure 2-31. Save Changes Screen
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Select the Adjust Alloy Threshold icon to configure pass and fail criteria 
for alloy analysis. Selecting the Adjust Alloy Threshold icon opens the 
Alloy Threshold Screen. 

Select the Set Display Units icon to choose between ppm (parts per 
million) and percentage (hundredths of whole) displays when taking 
readings. Selecting the Set Display Units icon opens the Display Units 
Screen.

Figure 2-32. Display Units Screen and Associated Results Screens

The Display Units Screen The Display Units Screen allows you to select either PPM or Percentage 
display on the Results Screen for Alloy, Industrial Bulk, or Plastic 
Modes. Select the radio button for the preferred display unit, then select the 
Save button, and subsequent results will be shown in that unit type. 

Note Readings will retain the unit type used when the reading was taken, 
even if the units are changed. 
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Cutoff numbers set the allowable limits in identifications of analyzed 
samples. The higher the cutoff is set, the easier a match can be made in the 
Alloy Analysis, Signature ID, and SuperChem modes. 
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The Erase Menu

Figure 2-33. The Erase Menu

To access the Erase Menu, select the Erase icon from the Data Menu. 
The Erase Menu enables you to delete data from your analyzer, allowing 
you to gain storage space for more recent data. You should only erase data 
which you have already transferred to permanent storage, or when requested 
to do so by Thermo service personnel.

Select the Erase All Data icon to erase all data, including signatures and 
SuperChem reference readings, from your analyzer. Selecting the Erase All 
Data icon will bring up a confirmation screen Figure 2-34) asking you “Are 
you sure?” with options to select “YES” or “NO”. Selecting “YES” will erase 
all reading data from your analyzer. Selecting “NO” will return you to the 
Erase Menu.

Select the Erase Readings icon to erase all accumulated test readings from 
your analyzer. Selecting the Erase Readings icon will bring up a 
confirmation screen Figure 2-34 asking you “Are you sure?” with options to 
select “YES” or “NO”. Selecting “YES” will erase all test reading data from 
your analyzer. Selecting “NO” will return you to the Erase Menu.

Select the Erase Signatures icon to erase all accumulated alloy signatures 
from your analyzer. Selecting the Erase Signatures icon will bring up a 
confirmation screen Figure 2-34 asking you “Are you sure?” with options to 
select “YES” or “NO”. Selecting “YES” will erase all signature data from 
your analyzer. Selecting “NO” will return you to the Erase Menu.
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Select the Erase SuperChem icon to erase accumulated SuperChem 
reference readings from your analyzer. Selecting the Erase SuperChem 
icon will bring up a confirmation screen Figure 2-34 asking you “Are you 
sure?” with options to select “YES” or “NO”. Selecting “YES” will erase all 
SuperChem reference reading data from your analyzer. Selecting “NO” will 
return you to the Erase Menu.

Select the Erase SuperPrec icon to erase accumulated SuperPrec reference 
readings from your analyzer. Selecting the Erase SuperPrec icon will bring 
up a confirmation screen Figure 2-34 asking you “Are you sure?” with 
options to select “YES” or “NO”. Selecting “YES” will erase all SuperPrec 
reference reading data from your analyzer. Selecting “NO” will return you to 
the Erase Menu.

Figure 2-34. Confirmation Screen

The confirmation screen has a progress meter which tells you how far along 
your erasure is at any given time.
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The Instrument
Setup Menu

Select the Backlight icon to toggle the display backlight on or off. 

CAUTION Enabling the backlight will reduce your battery pack operating 
time, requiring more frequent recharges. 

Select the Wireless Setup icon to access the Wireless Setup Menu. The 
Wireless Setup Menu enables you to configure the Bluetooth wireless 
networking for your analyzer.

Select the Hardware Setup icon to access the Hardware Setup Screen. 
The Hardware Setup Screen enables you to configure trigger, safety 
interlock, and proximity button use.

Select the Source Config icon to access the Source Config Screen. The 
Source Config Screen enables you to completely configure parameters and 
use of your analyzer’s excitation sources.

Select the Printer Setup icon to access the Printer Setup Screen. The 
Printer Setup Screen enables you to configure printer parameters.
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The Hardware Setup
Screen

Figure 2-35. The Hardware Setup Screen

The Hardware Setup Screen enables you to toggle various options on or 
off, as well as select certain hardware dependant modes. Selecting an empty 
checkbox enables the option and places a check in the box. Selecting a 
checked box disables the option and clears the box.

Figure 2-36. Selecting Options

Select
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Select the Proximity Start checkbox to toggle the use of the front proximity 
button. This enables the proximity button to be used to start taking a 
sample on contact. Some nations have laws or regulations which prohibit 
use of this feature. In this case, the feature will be disabled before shipping. 

Figure 2-37. Selecting Other Options

Select
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Select the Interlock Start checkbox to toggle the use of the rear interlock but-
ton. This requires the interlock button to be used to start taking a sample on
contact. Enabling the "Interlock Start" feature allows the user to start an anal-
ysis by depressing the rear interlock button on the analyzer. 

Figure 2-38. Select the Welding Mask Checkbox

Select
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Select the Weld Mask checkbox to toggle the use of the Welding Mask 
function. This reconfigures the calibration of the analyzer, enabling you 
to take readings using the Welding Mask.

Figure 2-39. Selecting Option Combinations for Multiple Effects

Select

Select

Select
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.

Figure 2-40. Changing the Max Time Parameter

Select the numbers box in the Max Time field to change the maximum 
seconds per reading. A virtual numeric keypad will appear, allowing you to 
set the number to whatever value you want, up to the maximum of 36000. 
When the max testing time is reached during an analysis, the analyzer 
reading will be automatically ended. Your analyzer will continue switching 
filters as needed until you terminate the reading or the Max Time is reached.

Select

Virtual Numeric Keypad
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The Source Config
Screen

Multi-source tests are used to either preferentially excite specific elements 
for increased sensitivity, or to cover a wider element range.

Figure 2-41. The Source Config Screen

The Source Config Screen enables you to directly enable or disable any 
source, or control the time that a source irradiates the sample before 
auto-switching to another source.

Figure 2-42. The Source Checkboxes
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Select the checkbox next to the source you want to use to determine exactly 
which of the sources contained in your Niton Analyzer is used for sample 
testing. Selecting an empty checkbox will enable that source and place a 
check into the box as an indicator. Selecting a checked box will disable the 
source and clear the box.

Figure 2-43. The Source Switch on Time Only Checkbox

Select the Source Switch on Time Only checkbox to toggle Time Switch 
Only Mode on or off. In Time Switch Only Mode, the Niton XLp 
analyzer will ignore the Alloy Library and only switch sources according to 
the time interval you set in the Time field for each source.
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Figure 2-44. The Source Time Fields

Select the Time field for the intended source to change the source switch 
time for that source. This enables you to set the number of seconds each 
enabled source is allotted before auto-switching will occur when needed 
during sample testing. Your Niton  XLpanalyzer will auto-switch from one 
source to another when the testing time for that source is greater than or 
equal to the time you have chosen, and the identified alloy is flagged as 
needing the switch in the Niton Alloy Library.
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Figure 2-45. The Source Time Editor

Select the “C” key to clear the current time, then from the virtual numeric 
key pad, select each digit you want to input, then select “E” to enter.

Figure 2-46. New Time Displayed
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The Printer Setup
Screen

Figure 2-47. The Printer Setup Screen

The Printer Setup Screen allows you to adjust which sections of your 
reading data are sent to your optional printer. By default, your analyzer 
prints the detected list, reading number, reading length, reading mode and 
any applicable measurement data such as Alloy match grade names. You can 
select any combination of options on the Printer Setup Screen to change 
what is printed.

Print < LOD Selecting this option will enable printing of readings which are lower than 
the Limit of Detection.

Print Complete Selecting this option will enable printing of all the data fields in the reading.

Print Data Field Selecting this option will enable printing of all entered data fields.
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Industrial Bulk
Calibration Factors

Note Your NITON Analyzer may not be equipped with Industrial Bulk 
Mode. If you do not have Industrial Bulk Mode enabled on your analyzer, 
this section will not apply to you. 

Use Industrial Bulk mode when you expect that the element of interest to 
you will be more than 1% of the total sample. If you expect that the element 
of interest to you will be less than 1% of the total sample, use Standard Soil 
mode. 

Within Industrial Bulk mode there are two sub-modes; Industrial Bulk (Cu 
/ Zn / Pb) and Industrial Bulk (Ta / Hf / Re). Use Industrial Bulk (Ta / Hf / 
Re) mode only if you are specifically looking for compounds that contain 
those elements. If you are not specifically looking for compounds that 
contain tantalum, hafnium, or rhenium, then start by using Industrial Bulk 
(Cu / Zn / Pb) mode. This mode is more common than Industrial Bulk (Ta 
/ Hf / Re) mode.

The XRF Analyzer can quickly identify and measure the presence of many 
elements, but it can not detect the lighter elements, such as carbon and 
silicon. However, concentrations of these lighter elements can affect the 
measurement of the heavier elements. Calibration factors are used to correct 
for the presence of these light elements in the sample matrix. 

Industrial Bulk mode lets you calculate your own site-specific calibration 
factors and add them to the XRF Analyzer. 

When you begin using the XRF Analyzer, NITON recommends that you 
test the XRF Analyzer against known samples of the material of interest, and 
add calibration factors, if needed.

When you change to a material that has a different matrix, such as moving 
from a matrix with high carbon content to a matrix with high silicon 
content, NITON recommends that you again test the XRF Analyzer against 
known samples. If the XRF Analyzer still provides results that are accurate 
enough for your needs, you can continue to use it without changing the 
calibration factors. However, if the change in the matrix of the sample causes 
a change in the results from the XRF Analyzer, such that they are no longer 
accurate enough for your needs, then calculate new calibration factors for 
the new sample type.
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Displaying the
Calibration Factors

To display the calibration factors:

1. From the Main menu of the XRF Analyzer, select Common 
Setup.

2. Select Adjust Calibration.

3. Select the mode in which to adjust the call factors.

Figure 2-48. Select Mode 

Once you have selected the mode yoou want to edit, the CalFactor Screen fr 
that mode will appear.
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Figure 2-49. CalFactors Screen (for Inustrial Bulk Cu/Zn/Pb)

There are 5 CalFactor sets, four of which you can edit. Initially, before you 
edit them, CalFactor sets 1 through 4 are copies of the Factory setting, 
which is itself not editable. Select the set you want to edit, then select the 
EDIT button. An information screen pops up briefly before the editing 
screen appears.
Thermo Scientific NITON XLp Analyzer User’s Guide 49



The Menu System
Displaying the Calibration Factors
Figure 2-50. Information Screen

Figure 2-51. CalFactors Edit Screen
50 NITON XLp Analyzer User’s Guide Thermo Scientific



The Menu System
Displaying the Calibration Factors
The Calibration Factors
Edit Screen

To edit the element you are interested in, select the intersection of the row 
of that element with the Slope or Intercept columns - for example, if you 
want to edit the slope of Selenium, select the 1.00 default slope appearing in 
the Sn row. A Slope Editor for that element will appear.

Figure 2-52. Slope Editor (Selenium)

The Slope Editor is a virtual numeric keypad, which works much like the 
login keypad. Clear the default or old data from the box with the “C” key, 
select the numbers to input the new slope, and select the “E” key to save the 
new value. You will be returned to the CalFactors Screen, and the new slope 
will be there.
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Figure 2-53. New Slope as Edited

Like the Slope Editor, the Intercept Editor is a virtual numeric keypad, 
which works much like the login keypad. Clear the default or old data from 
the box with the “C” key, select the numbers to input the new intercept, and 
select the “E” key to save the new value. You will be returned to the 
CalFactors Screen, and the new intercept will be there.
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Figure 2-54. Intercept Editor

Figure 2-55. Intercept as Edited

• You can use the scroll bar to mover around in the list of elements.
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• Selecting the Save button will save the new CalFactor set.

• Selecting the Reset Button will copy the Factory Setting over the 
current setting, resetting the CalFactors back to Factory Standard.

• Selecting the Close button will exit the CalFactors Edit screen and 
return you to the CalFactors screen.

Figure 2-56. Renamed CalFactor Set

To change the name of the set, select the keyboard icon to load the Virtual 
Keyboard at the top of the CalFactors Edit Screen, and rename the set. Set 
names can be up to 9 characters long. 
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Adjusting the
Calibration Factors

Calibration factors are used to adjust for consistently high or consistently 
low readings from the XRF Analyzer.

They are calculated by graphing the data points created by plotting the 
percentage of each element as indicated by standard samples, against the 
percentage of each element as reported by the XRF Analyzer.

Then the linear regression function is used to calculate the slope and 
intercept for a straight line that best fits these data points. The slope and 
intercept of this line are the calibration factors. 

Calculating calibration factors requires several steps:

1. Resetting the Calibration Factors

2. Measuring Standard Samples

3. Calculating Calibration Factors

4. Adding the Calibration Factors to the XRF Analyzer

These steps are described in detail below.

Resetting the Calibration
Factors

To reset the calibration factors to the defaults:

1. Display the calibration factors. See “Displaying the Calibration 
Factors” on page 2-48 for detailed instructions.

2. Press the Escape button to switch to the Calibration Factors 
Menu.

3. Press RES on the Calibration Factors Menu. The XRF Analyzer 
resets the calibration factors to the defaults.

Measuring the Standard
Samples

Use the XRF Analyzer to take readings of samples for which you already 
know the composition of the sample. It is important that the known 
composition of these samples be accurate. These samples provide the 
baseline to which the XRF Analyzer is adjusted. If the known composition is 
inaccurate, the XRF Analyzer will also be inaccurate.
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For each sample, take a reading of at least 120 seconds. Make a note of the 
reading numbers for these samples.

For each sample, the XRF Analyzer reports the percentage by weight for the 
elements present in the sample. With the calibration factors set to the 
defaults, these percentages will differ from the known percentages, but are 
used to calculate the calibration factors.

Note Readings from only three samples are required for each element, but 
increasing the number of readings also increases the accuracy of the results.

Calculating Calibration
Factors

Using the data that you collected by measuring the standard samples, you 
now need to plot the percentage of each element as indicated by the 
standard samples, against the percentage of each element as reported by the 
XRF Analyzer. Then use the linear regression function to calculate the slope 
and intercept for a straight line drawn through a graph of those data points.

The slope and intercept for this line are the calibration factors for the 
element.

You may use any tools that you prefer to make this calculation. This 
document shows one possible method, using Excel. 

Note The XRF Analyzer reports percentages of elements, and the 
calibration factors are based on percentages of elements. If your standard 
samples indicate percentages of oxides, see “Oxide Conversion” on 
page 2-63 to convert percentages of oxides to percentages of elements.

Calculating Calibration
Factors Using Excel

Note NITON also provides CorrectCalcTM, an Excel-based software 
program that calculates the calibration factors. It also provides some 
additional calculations and a graph of your data. For more information, see 
the CorrectCalc Manual, which is provided as a PDF file on the NDT 
Software CD.

To calculate calibration factors:

1. Open Excel. To do this:

a. Click the Start button.

b. Select Programs.
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c. Click Microsoft Excel.

Figure 2-57. Starting Excel

1. In the first column, enter all the percentages by weight for the 
element as reported by the XRF Analyzer

.

Figure 2-58. Adding Data

Click Start

Select Programs

Click Microsoft Excel

Percentages by weight as 
indicated by each standard

Percentages by weight as reported by 
the XRF Analyzer
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2. In the second column, enter all the percentages by weight for the 
element as indicated by each standard.

3. Use the cursor to highlight all the numbers in both columns.

Figure 2-59. Setting Up the Chart

4. Click Chart Wizard.

5. Select the Scatter Chart with data points that are not connected 
by lines.
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Figure 2-60. Selecting the Scatter Chart

6. Click Finish.

7. Right-click on one of the data points.

8. Click Add Trendline on the pop-up menu. 

Figure 2-61. Adding the Trendline

Click to select the scatter 
chart without lines

Click 
Finish

Click Add Trendline 
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Note If you do not have Add Trendline as an option on this menu, see 
“Adding the Analysis ToolPak to Excel:” on page 2-64 for instructions.

a. On the Type tab, click Linear.

Figure 2-62. Selecting Linear Trendline

b. On the Options tab, check the boxes for “Display equation on 
chart” and “Display R-squared value on chart.”

Click 
Linear
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Figure 2-63. Selecting Options

c. Click OK.

d. The equation shows the slope and intercept for the trend line. These 
are the calibration factors that you enter into the XRF Analyzer.

Figure 2-64. Slope and Intercept Displayed

Note If the intercept is negative in the equation, be sure that you enter the 
intercept as negative in the XRF Analyzer. 

Click OK

Check these 
boxes

Slope Intercept
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9. Repeat these steps to find the slope and intercept for every 
element that you are interested in.
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Oxide Conversion If the composition of your standard sample is specified in percentage of 
oxide, multiply that percentage by the conversion factor in the table to find 
the percentage of the element. For example, if the standard sample contains 
4% TiO2, it contains 2.398% Ti:

4 * 0.5995 = 2.398

Table 2-1. Table of Oxide Percentages

Oxide Conversion Factor

TiO2 0.5995

V2O5 0.5602

Cr2O3 0.6842

Mn3O4 0.7203

MnO 0.7745

Fe2O3 0.6994

FeO 0.7773

Co3O4 0.7342

NiO 0.7858

CuO 0.7988

ZnO 0.8034

PbO 0.9283

Fe2O3 0.6994

Bi2O3 0.8970

ZrO2 0.7403

MoO3 0.6665

WO3 0.7930

Ta2O5 0.8190

Nb2O5 0.6990

SnO2 0.7876
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If your standard sample contains a compound that is not listed in the 
table, you can calculate the percentage of the element using this formula:

Adding the Analysis
ToolPak to Excel:

1. Within Excel, select Add-Ins from the Tools menu.

Figure 2-65. Selecting Add-Ins

2. Click the box for Analysis ToolPak 

Figure 2-66. Selecting Analysis ToolPak

(molecular weight of the element)

(molecular weight of the compound)
* (% of compound) (% of element)=

Click the box for Analysis ToolPak

Click OK
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3. Click OK.

Note If you need more information about the Analysis ToolPak, see the 
documentation for Excel. 
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Certified Values for
Bulk Standards

The three NIST soil samples included with your bulk testing kit (Low, 
Medium, and High) are certified to the following specifications in these 
selected elements:

The complete Certificate of Analysis can be obtained from the NIST web 
site at: http://patapasco.nist.gov/smcatalog/certificates/2709.pdf 

Table 2-2. Low Standard - NIST #2709 (Discontinued)

Element Mass 
Fraction
%

Variation
%

Element Mass 
Fraction
g/g

Variation
g/g

Aluminum 7.50 + 0.06 Antimony 7.9 + 0.6

Calcium 1.89 + 0.05 Arsenic 17.7 + 0.8

Iron 3.50 + 0.11 Barium 968.0 + 40

Magnesium 1.51 + 0.05 Cadmium 0.38 + 0.01

Phosphorus 0.062 + 0.005 Chromium 130.0 + 4.0

Potassium 2.03 + 0.06 Cobalt 13.4 + 0.7

Silicon 29.66 + 0.23 Copper 34.6 + 0.7

Sodium 1.16 + 0.03 Lead 18.9 + 0.5

Sulphur 0.089 + 0.002 Manganese 538.0 + 17.0

Titanium 0.342 + 0.024 Mercury 1.40 + 0.08

+ Nickel 88.0 + 5.0

+ Sel enium 1.57 + 0.08

+ Si lver 0.41 + 0.03

+ S trontium 231.0 + 2.0

+ Thallium 0.74 + 0.05

+ V anadium 112.0 + 5.0

Zinc 106.0 + 3.0
66 NITON XLp Analyzer User’s Guide Thermo Scientific



The Menu System
Certified Values for Bulk Standards
Table 2-3. Non-Certified Values - NIST Standard 2709 (Discontinued

Element Mass 
Fraction
%

Element Mass 
Fraction
g/g

Carbon 1.2 Cerium 42.0

Cesium 5.3

Dysprosium 3.5

Europium 0.9

Gallium 14.0

Gold 0.3

Hafnium 3.7

Holmium 0.54

Iodine 5.0

Lanthanum 23.0

Molybdenum 2.0

Neodymium 19.0

Rubidium 96.0

Samarium 3.8

Scandium 12.0

Thorium 11.0

Tungsten 2.0

Uranium 3.0

Ytterbium 1.6

Yttrium 18.0

Zirconium 160.0
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The complete Certificate of Analysis can be obtained from the NIST web 
site at: http://patapasco.nist.gov/smcatalog/certificates/2711.pdf 

Table 2-4. Medium Standard - NIST # 2711 (Discontinued)

Element Mass 
Fraction
%

Variation
%

Element Mass 
Fraction
g/g

Variation
g/g

Aluminum 6.53 + 0.09 Antimony 19.4 + 1.8

Calcium 2.88 + 0.08 Arsenic 105.0 + 8.0

Iron 2.89 + 0.06 Barium 726.0 + 38.0

Magnesium 1.05 + 0.03 Cadmium 41.7 + 0.25

Phosphorus 0.086 + 0.007 Copper 114.0 + 2.0

Potassium 2.45 + 0.08 Lead 1162.0 + 31.0

Silicon 30.44 + 0.19 Manganese 638 + 28.0

Sodium 1.14 + 0.03 Mercury 6.25 + 0.19

Sulphur 0.042 + 0.001 Nickel 20.6 + 1.1

Titanium 0.306 + 0.023 Selenium 1.52 + 0.14

+ Si lver 4.63 + 0.39

+ S trontium 245.3 + 0.7

+ Tha llium 2.47 + 0.15

+ V anadium 81.6 2.9

+ Zinc 350.4 4.8
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Table 2-5. Non-Certified Values - NIST Standard 2711 
(Discontinued)

Element Mass 
Fraction
%

Element Mass 
Fraction
g/g

Carbon 2.0 Bromine 5.0

Cerium 69.0

Cesium 6.1

Chromium 47.0

Cobalt 10.0

Dysprosium 5.6

Europium 1.1

Gallium 15.0

Gold 0.03

Hafnium 7.3

Holmium 1.0

Indium 1.1

Iodine 3.0

Lanthanum 40.0

Molybdenum 1.6

Neodymium 31.0

Rubidium 110.0

Samarium 5.9

Scandium 9.0

Thorium 14.0

Tungsten 3.0

Uranium 2.6

Ytterbium 2.7

Yttrium 25.0

Zirconium 230.0
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The complete Certificate of Analysis can be obtained from the NIST web 
site at: http://patapasco.nist.gov/smcatalog/certificates/2710.pdf 

Table 2-6. High Standard - NIST # 2710

Element Mass 
Fraction
%

Variation
%

Element Mass 
Fraction
g/g

Variation
g/g

Aluminum 6.44 + 0.08 Antimony 38.4 + 3.0

Calcium 1.25 + 0.03 Arsenic 626.0 + 38.0

Iron 3.38 + 0.10 Barium 707.0 + 51.0

Magnesium 0.853 + 0.042 Cadmium 21.8 + 0.2

Manganese 1.01 + 0.04 Copper 2950.0 + 130.0

Phosphorus 0.106 + 0.015 Lead 5532.0 + 80.0

Potassium 2.11 + 0.11 Mercury 32.6 + 1.8

Silicon 28.97 + 0.18 Nickel 14.3 + 1.0

Sodium 1.14 + 0.06 Silver 35.3 + 1.5

Sulfur 0.240 + 0.006 Vanadium 76.6 + 2.3

Titanium 0.283 + 0.010 Zinc 6952.0 + 91.0
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Table 2-7. Non-Certified Values - NIST Standard 2710

Element Mass 
Fraction
%

Element Mass 
Fraction
g/g

Carbon 1 Bromine 6

Cerium 57

Cesium 107

Chromium 39

Cobalt 10

Dysprosium 5.4

Europium 1

Gallium 34

Gold 0.6

Hafnium 3.2

Holmium 0.6

Indium 5.1

Lanthanum 34

Molybdenum 19

Neodymium 23

Rubidium 120

Samarium 7.8

Scandium 8.7

Strontium 330

Thallium 1.3

Thorium 13

Tungsten 93

Uranium 25

Ytterbium 1.3

Yttrium 23
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Table 2-8. NITON Analyzers Soil Standards Substitutions Comparisons

Element NCS DC 
73308

NIST Low Element TILL-4 NIST 
Medium

Ag 0.27 +/- 0.02 0.41 +/- 0.03 Ag 4.6 +/- 0.4

As 25 +/- 3 17.7 +/- 0.8 As 111 105 +/- 8

Au (0.3) Au 5 ppb (0.03)

Ba 42 +/- 7 968.0 +/- 40.0 Ba 395 726 +/- 38

Be 0.9 +/- 0.2 Be 3.7

Bi 0.38 +/- 0.04 Bi 40

Br 2.4 +/- 0.5 Br 8.6 (5)

Ca (%) 0.28 1.89 +/- 0.05 Ca (%) 0.89 2.88 +/- 0.08

Cd 1.1 0.38 +/- 0.01 Cd 41.7 +/- 0.25

Ce 38 +/- 4 (42) Ce 78 (69)

Co 15.3 +/- 1.1 13.40 +/- 0.70 Co 8 (10)

Cr 136 +/- 10 130.00 +/- 
4.00

Cr 53 (47)

Cs 2.3 +/- 0.5 (5.3) Cs 12 (6.1)

Cu 22.6 +/- 1.3 34.6 +/- 0.7 Cu 237 114.0 +/- 2.0

Eu 0.47 +/- 0.04 (0.9) Eu <1.0 (1)

Er 1.3 +/- 0.2 Er 3.2

Fe (%) 2.7 3.50 +/- 0.11 Fe (%) 3.97 2.89 +/- 0.06

Ga 6.4 +/- 0.7 (14) Ga (15)

Gd 2.2 +/- 0.2 Gd

Ge 0.40 +/- 0.06 Ge

Hf 1.8 +/- 0.4 (3.7) Hf 10 (7.3)

Hg 0.28 +/- 0.03 1.4 +/- 0.08 Hg 6.3 +/- 0.2

I 1.6 +/- 0.3 I

In 0.067 +/- 
0.016

In (1.1)

K (%) 1041 ppm 2.03 +/- 0.06 K (%) 2.70 2.45 +/- 0.08

La 13.0 +/- 0.9 (23) La 41 (40)

Li 13.0 +/- 0.5 Li 30

Mn 1010 +/- 29 538.0 +/- 17.0  Mn 490 638 +/- 28

Mo 1.2  +/- 0.1 (2.0) Mo 16 (1.6)

Nb 6.8 +/- 1.3 Nb 15
72 NITON XLp Analyzer User’s Guide Thermo Scientific



The Menu System
Certified Values for Bulk Standards
values in mg/kg unless otherwise specified

uncertified values in parentheses

Nd 11.8 +/- 1.1 Nd 30

Ni 30 +/- 2 88.0 +/- 5.0 Ni 17 20.6 +/- 1.1

P 271 +/- 15 0.062% +/- 
0.005%

P 880 0.086% +/- 
0.007%

Pb 27 +/- 2 18.9 +/- 0.5 Pb 50 1162 +/- 31

Rb 9.2 +/- 1.5 (96) Rb 161 (110)

S (%) (90 mg/kg) 0.089 +/- 
0.002

S (%) 0.08 0.042 +/- 
0.001

Sb 6.3 +/- 0.6 7.9 +/- 0.6 Sb 1 19.4 +/- 1.8

Sc 4.1 +/- 0.4 (12.0) Sc 10 (9.0)

Se 1.57 +/- 0.08 Se 1.5 +/- 0.1

Si (%) 41.55 29.66 +/- 0.23 Si

Sm 2.4 +/- 0.2 Sm 6.1

Sr 25 +/- 3 231.0 +/- 2.0 Sr 109 245.3 +/- 0.7

Ta 0.44 +/- 0.12 Ta 1.6

Tb 0.42 +/- 0.07 Tb 1.1

Th 5.0 +/- 0.3 (11.0) Th 17.4 (14.0)

Ti (%) 0.127 +/- 
0.007

0.342 +/- 
0.024

Ti (%) 0.484 0.306 +/- 
0.023

U 2.1 +/- 0.2 (3.0) U 5 (2.6)

V 107 +/- 5 112.0 +/- 5.0 V 67 81.6 +/- 2.9

W 1.6 +/- 0.3 (2.0) W 204 (3.0)

Y 14 +/- 2 (18.0) Y 33 (25.0)

Yb 1.2 +/- 0.2 Yb 3.4

Zn 46 +/- 4 106.0 +/- 3.0 Zn 70 350.4 +/- 4.8

Zr 70 +/- 6 (160.0) Zr 385 (230.0)

Table 2-8. NITON Analyzers Soil Standards Substitutions Comparisons

Element NCS DC 
73308

NIST Low Element TILL-4 NIST 
Medium
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Replacement Standards for Discontinued NIST Samples

Table 2-9. Low Standard - NCS DC 73308 (Replaces NIST 2709)

Element Mass 
Fraction
g/g

Variation
g/g

Ag 0.27 + 0.02

As 25 + 3.

Au + 

B 26 +4

Ba 42 +7

Be 0.9 + 0.2

Bi 0.38 + 0.04

Br 2.4 + 0.5

Cd 1.12 + 0.08

Ce 38 + 4

Cl [53] + 

Co 15.3 + 1.1

Cr 136 + 10

Cs 2.3 +0 .5

Cu 22.6 +1.3

Dy 2.2 + 0.3

Er 1.3 + 0.2

Eu 0.47 + 0.04

F 149 + 25

Ga 6.4 + 0.7

Gd 2.2 + 0.2

Ge 0.40 + 0.06

Hf 1.8 + 0.4

Hg 0.28 + 0.03

Ho 0.45 + 0.07

I 1.6 + 0.3

In 0.067 + 0.016

La 13.0 + 0.9

Li 13.0 + 0.5

Lu 0.19 + 0.03

Mn 0.41010 + 29
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Data enclosed in brackets [x.y] are reference values.

Mo 1.2 + 0.1

N [360] + 

Nb 6.8 + 1.3

Nd 11.8 + 1.1

Ni 30 + 2

P 271 + 15

Pb 27 + 2

Pr 3.2 + 0.4

Rb 9.2 + 1.5

S [90] + 

Sb 6.3 + 0.6

Sc 4.1 + 0.4

Se 0.28 + 0.05

Sm 2.4 + 0.2

Sn 1.4 + 0.3

Sr 25 + 3

Ta 0.44 + 0.12

Tb 0.42 + 0.07

Te 0.08 + 0.02

Th 5.0 + 0.3

Ti 1270 + 70

Tl 0.21 + 0.05

Tm 0.20 + 0.03

U 2.1 + 0.2

V 107 + 5

W 1.6 + 0.3

Y 14 + 2

Yb 1.2 + 0.2

Zn 46 + 4

Zr 70 + 6

Table 2-9. Low Standard - NCS DC 73308 (Replaces NIST 2709)

Element Mass 
Fraction
g/g

Variation
g/g
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Table 2-10. Medium Standard - TILL-4 (Replaces NIST 2711)

Element Mass 
Fraction
%

Element Mass 
Fraction
g/g

Fe 3.97 As 111

LOI (500oC) 4.4 Au 0.005

S 0.08 Ba 395

Be 3.7

Bi 40

Br 8.6

Ce 78

Co 8

Cr 53

Cs 12

Cu 237

Eu <1.0

Er 3.2

Hf 10

La 41

Li 30

Lu 0.5

Mn 490

Mo 16

Nb 15

Nd 30

Ni 17

P 880

Pb 50

Rb 161

Sb 1.0

Sc 10

Sm 6.1

Sr 109

Ta 1.6

Tb 1.1
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Th 17.4

Ti 4840

U 5.0

V 67

W 204

Y 33

Yb 3.4

Zn 70

Zr 385

Table 2-10. Medium Standard - TILL-4 (Replaces NIST 2711)

Element Mass 
Fraction
%

Element Mass 
Fraction
g/g
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Chapter 3 Alloy Testing

Using Alloy Testing
Mode

Alloy Testing Mode is not enabled on your NITON XLp analyzer. For more 
information on this feature please contact NITON’s Customer Service 
Department in the United States, Toll free, at (800) 875-1578, or outside 
the United States at + 1-978-670-7460 or your authorized NITON Service 
Center.
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Chapter 4 Pb Paint Mode

Using Pb Paint
Mode

Your NITON XLp-300 Series Lead-in-Paint Analyzer is designed to detect 
and quantify the amount of lead present in painted surfaces. Your analyzer 
also tracks important information about your site readings using the 
integrated bar-code scanner or the analyzer’s control panel. 

Lead Paint inspection guidelines and protocols are specific to the country 
and state in which the testing is being performed. For the HUD testing 
guidelines and the NITON Analyzer Performance Characteristic Sheet 
(PCS), please go to www.hud.gov 
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The Pb Paint Mode
Menu

Figure 4-1. The Pb Paint Mode Menu

All NITON XLp-300 Series Lead-in-Paint Analyzer Mode functions are 
accessible from the Pb Paint Mode Menu and subsidiary menus. Each of the 
instrument functions represented by an icon on the Pb Paint Mode Menu 
screen may be selected by choosing the appropriate icon. When one of these 
Pb Paint Mode Menu icons is selected, the function specific sub-menu 
appropriate to that icon will be displayed. All Lead-In-Paint modes use both 
L and K shell analysis simultaneously.

The Standard Mode icon allows you to select the Lead-in-Paint Standard 
Mode. Standard Mode is a qualitative analysis designed for 95% confidence 
level as to whether the sample is above or below the Action Level. This mode 
tends to give very fast readings. as it terminates the test as soon as 95% 
confidence has been achieved.

The K+L Mode icon allows you to select the Lead-in-Paint K+L Mode. K+L 
Mode is a quantitative analysis which allows you to determine the statistical 
confidence of the reading to a 95% Confidence Level while allowing you the 
flexibility of continuing the test for as long as you wish up to the 
(user-definable) maximum test time.

The Set Action Level icon allows you to set the action level for Lead-in-Paint 
to match the official action level of your locality.
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Menu

Figure 4-2. The Standard Mode Menu

All NITON XLp  Standard Mode functions are accessible from the 
Standard Mode Menu and subsidiary sub-menus. From the Standard 
Mode Menu, you can immediately initiate a sample test using the proper 
preconditions for operation, enter data about your sample using the Data 
Entry icon, or return to the Main Menu.

Select the Data Entry icon from the Standard Mode Menuto go to the 
“The Data Entry Screens” on page 4-10, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.
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The K+L Mode
Menu

Figure 4-3. The K+L Mode menu

All NITON XLp  K+L Mode functions are accessible from the K+L Mode 
Menu and subsidiary sub-menus. From the K+L Mode Menu, you can 
immediately initiate a sample test using the proper preconditions for 
operation, enter data about your sample using the Data Entry icon, or 
return to the Main Menu.

Select the Data Entry icon from the K+L Mode Menuto go to the “The 
Data Entry Screens” on page 4-10, to input data about the sample which 
you are testing. The data you enter will be associated with the next sample 
you test.
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The Set Action Level
Screen

The Set Action Level Screen is accessible from the Paint Mode Menu. When 
the Set Action Level icon is selected, the Set Action Level Screen will be 
displayed.

Figure 4-4. The Set Action Level Screen

To change the preset Action Level to match the Action Level set by your 
locality, select the “C” key from the Virtual Numeric Keypad to clear the 
current Action Level value, select the new Action Level value using the 
numeric keys, then select “E” to enter the new Action Level value. The 
Action Level will be changed to the new value.

Figure 4-5. Changing the Action Level
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CAUTION After being powered on, the NITON 300 Series Analyzer will 
perform an internal re-calibration before an analysis is initiated.  It is 
recommended that you let your instrument warm up for ten minutes after 
start up, before testing is begun. 

There are five different methods of operation for taking a sample 
measurement, and your analyzer will be configured to use one of those 
methods, depending on the regulatory requirements of your locality. These 
methods are:

• Trigger-Only method. With the Trigger-Only method, you only 
need to place the measurement window close to the sample to be 
analyzed and pull the trigger for sample analysis to be initiated. 

• Trigger-and-Proximity-Sensor method. With the 
Trigger-and-Proximity-Sensor method, you must place the 
measurement window against the sample to be analyzed to engage 
the proximity sensor on the front of the instrument, then pull the 
trigger for sample analysis to be initiated.

• Momentary-Trigger-Touch-and-Proximity-Sensor method. With 
the Momentary-Trigger-Touch-and-Proximity-Sensor method, you 
must place the measurement window against the surface to be 
analyzed to engage the proximity sensor on the front of the 
instrument, then pull the trigger.

• The trigger may be released and the reading will continue until you 
release the proximity button, or other criteria (such as Max Time) 
are reached.

• Trigger-and-Interlock method. With the Trigger-and-Interlock 
method, you need to place the measurement window close to the 
sample to be analyzed, press and keep pressing the interlock button 
at the rear of the instrument with your free hand, then pull the 
trigger for sample analysis to be initiated.

• Trigger-Interlock-and-Proximity-Sensor method. With the 
Trigger-Interlock-and-Proximity-Sensor method, you must place the 
measurement window against the sample to be analyzed to engage 
the proximity sensor on the front of the instrument, press and keep 
pressing the interlock button at the rear of the instrument with your 
free hand, then pull the trigger for sample analysis to be initiated.
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With any of these methods, analysis will stop if any one of the preconditions 
are violated. For example, with the Trigger-Interlock-and-Proximity-Sensor 
method, if the trigger or the Proximity Sensor or the Interlock is released, 
the reading will stop immediately, and the shutters will close.

After your NITON XLp analyzer is calibrated, initiate a sample reading 
using the appropriate method. If you attempt to initiate a sample reading 
using a different method, the analyzer will inform you that one or more of 
the preconditions need to be met in order for sample analysis to begin. 

Note The three LED lights will blink during calibration or whenever there 
is a shutter open. 

WARNING!  The preconditions for operation must be continued for the 
duration of the reading. If the preconditions are violated, all the shutters will 
close, and the measurement will end. The three LED lights will stop 
blinking, the shutters will close, and the measurement will end. The flashing 
of the LED lights is not synchronized to minimize power consumption. 

WARNING!  The three LED warning lights are designed to blink only 
during  a measurement, where one or more of the shutters are open and the 
trigger depressed. If the LED lights blink at any other time, disconnect the 
battery pack immediately, place the instrument in its shielded holster, place 
the holster in the shielded carrying case, and call Thermo Scientific’s Service 
Department in the United States, toll free, at (800) 875-1578, or outside 
the United States, at +1-978-670-7460, or your local Authorized NITON 
Analyzers Service Center. 

Your NITON Analyzer will display the Results Screen throughout the 
duration of each reading, The Results Screen is updated regularly 
throughout the reading. When the reading is complete, a final screen update 
will appear, and your NITON analyzer will display the final results of the 
measurement which has just been completed.
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Results Screen

Figure 4-6. Standard Mode Results Screen

Before the analyzer has reached a determination, the result will be shown as 
“Inconclusive”. Your analyzer will beep twice when a result is reached then 
terminate the reading. The display will change from “Inconclusive” to show 
the result, either “Positive” for lead detected above the action level, or 
“Negative” for no lead or lead below the action level. It will also display the 
amount of lead detected in mg/cm2.

The Depth Index is a numerical value indicating the amount of non-leaded 
paint covering the lead (if any) detected by the analyzer. 

• A Depth Index of less than 1.5 indicates a reading very near the surface. 

• A Depth Index between 1.6 and 4.0 indicates a moderate depth. 

• A Depth Index of greater than 4.0 indicates a deeply buried reading.

Reading Number

Nominal Seconds
for this Reading

Analysis Mode

Result

Lead detected in

mg/cm2

Depth Index

NAV MENU 

TOOLS MENU 
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K+L Mode Results
Screen

Figure 4-7. K+L Mode Results Screen

The K+L Mode Results Screen will show the same basic display throughout 
the reading. Your analyzer will beep twice to indicate it has reached a 
conclusion, and the Result field will change from “Inconclusive” to 
“Positive” or “Negative”, but the reading will continue for as long as you 
continue to hold down the trigger and depress the Proximity Sensor.

The K+L Results Screen shows the reading results and error for both K and 
L-shell readings. The “Lead Detected in mg/cm2 total” field is the result of 
the judgement of your analyzer as to which reading, K or L-shell, best 
represents the true condition. 

The Depth Index is a numerical value indicating the amount of 
non-leaded paint covering the lead (if any) detected by the analyzer. 

• A Depth Index of less than 1.5 indicates a reading very near the surface. 

• A Depth Index between 1.6 and 4.0 indicates a moderate depth. 

• A Depth Index of greater than 4.0 indicates a deeply buried reading.

Reading Number

Nominal Seconds
for this Reading

Analysis Mode

Result

Lead detected in

mg/cm2 total

NAV MENU

TOOLS MENU

L-shell

K-shell

Depth Index

Reading

Error

Column

Column
Lead detected in

Lead detected in
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The Data Entry
Screens

The Data Entry Screens allow you to set the values for various parameters 
tracked by the system along with the actual analysis results. This screen 
allows you to input data in several different fields, or categories, concerning 
your sample, in several different ways:

• By selecting the Virtual Keyboard button and typing the parameter in 
using the Virtual Keyboard. 

• By scanning in the parameter name using the integrated bar code 
scanner.

• By creating a new, or editing your analyzer's existing, '.ndf' file through 
the NDT program. You can then select from the various custom options 
you have created using the Drop-down List button.

These fields are saved along with the subsequent reading, and allow you to 
associate important information about the sample directly with the reading, 
so that you have a full description of the sample tied into the reading itself.

These parameters all describe the particular test target to be analyzed. The 
location of the target in the site, the type of target, the surface and substrate, 
the condition of the surface, and the inspector performing the test are some 
of the parameters tracked by the analyser.
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The Data Entry Screens
Navigating the Data
Entry Screen

Figure 4-8. Navigating the Data Entry Screen

Above is a sample of the Data Entry Screen. To navigate through the Data 
Entry Screen and select your parameter settings, you can use the touch 
screen display or 4-way touch pad and control panel buttons. 

Name of the
Menu Code

Keyboard 

Tools MenuNAV Menu

Parameter 
Number

Parameter

Button

Value Drop-Down
Menu Button
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Navigating the Data
Entry Screen

Figure 4-9. The Control Panel

The following description of screen navigation using the control panel 
assumes that the analyzer is held so that the display is held upright as in 
Figure 4-9.

• To move from column to column, use the Right and Left portion of the 
4-way touch pad.

• To move from row to row, use the Up and Down portions of the 4-way 
touch pad.

• To select the highlighted option, press the Enter button on the control 
panel. 

The Data Entry Screen is divided into sections of 5 setting parameters. By 
using the Down portion of the 4-way touch pad when you are on the last 
row of a section, the display will change to the next section. By using the Up 
portion of the 4-way touch pad when you are on the first row of a section, 
the display will change to the previous section. 

By selecting the On/Off button, you can exit the Data Entry Screen.

Touch Screen 
Display

On/Off 
Button

Down

Right

4-way
 touch-pad

Up

Enter
Button

Left
12 NITON XLp Analyzer User’s Guide Thermo Scientific



Pb Paint Mode
Using The Data Entry Screen
Using The Data
Entry Screen

Figure 4-10. The Data Entry Screen - First Section

This is the first section of the Data Entry Screen. There are five parameters 
in this section.

• Selecting Component allows you to input the reading location 
Component parameter.

• Selecting Color allows you to input the reading location Color 
parameter.

• Selecting Side allows you to input the reading location Side 
parameter.

• Selecting Substrate allows you to input the reading Substrate 
parameter.

• Selecting Replicant allows you to input the reading Replicant 
parameter.
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Figure 4-11. The Data Entry Screen - Second Section

This is the second section of the Data Entry Screen. There are five 
parameters in this section.

• Selecting Site allows you to input the reading Site parameter.

• Selecting Space Type allows you to input reading the reading 
location Space Type parameter.

• Selecting Space allows you to input the reading location Space 
parameter.

• Selecting Rm/Fl No allows you to input the reading location Rm/Fl 
No parameter.

• Selecting Room allows you to input the reading Room parameter.
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Figure 4-12. The Data Entry Screen - Third Section

This is the third section of the Data Entry Screen. There is one parameter in 
this section.

• Selecting Inspector allows you to input the reading Inspector 
parameter.

• Selecting the Menu Code Number will initiate a bar code scan to input 
pre-printed bar code parameter values

• Selecting the Drop-Down Menu Button will access the particular 
Drop-Down Menu for that parameter, allowing you to select the 
parameter value from a pre-determined list.

• Selecting the Keyboard button allows you to input a parameter value as 
required using the Virtual Keyboard.
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Lead in Consumer
Products

Your analyzer is capable of screening toys, children’s jewelry, and other 
consumer products for the presence of Lead (Pb). The primary goal of 
screening is not to accurately analyze the chemical composition of all 
components or parts of the product, but to identify and segregate products 
containing prohibited elements.

Consumer Products SOP The following is the Standard Operating Procedure (SOP) for finding lead 
in consumer products.

Preparatory Tasks 1. Attach a charged battery to the analyzer and turn it on. Follow 
the screen instructions and Log On as the operator.

2. Wait five (5) minutes before using the analyzer, allowing the 
instrument’s electronics to stabilize.

3. Verify that the date is set properly for data tracking purposes.

4. From the Main Menu, select Utilities -> Instrument Specs. The 
date will be displayed for verification. To escape back to the Main 
Menu, press the On/Off/Escape button. If the date is incorrect, 
correct it prior to proceeding. 

5. If testing will be performed on small samples, mount the analyzer 
in its optional test stand. Any sample that does not completely 
cover the analyzer measuring window (aperture) is considered 
small. Also, samples that have a form of thin sheet, such as foil, 
paper, fabric, etc., should also be analyzed in a test stand.

(Optional) Connect the analyzer to a computer via the included serial cable 
or Bluetooth wireless module. Consult the Guide to NDTr and the 
Bluetooth Installation Guide document for details, if necessary.

6. During analysis and detector calibrations, it is important to 
ensure that the analyzer is not exposed to strong electromagnetic 
fields, including those produced by computer monitors, hard 
drives, cellular telephones, walkie talkies, etc. Keep a minimum 
two (2) feet (0.7 meters) distance between the analyzer and 
electronic devices.
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7. From the Main Menu, select Utilities‡ Calibrate -> Calibrate 
Detector.

a. Detector calibration standardizes the detector. After starting the 
process, no further user interaction is required during this operation. 
Note the “Res” figure displayed following the detector calibration. 
This number, usually <500eV, is an evaluation of the detector 
resolution and should be consistent with past calibration results. 
This data will download as a stored reading if the user chooses to 
download readings, so it can be saved for tracking the instrument’s 
performance

b. If the “Res” number is consistent with past detector calibration 
results, continue to step 8.

c. If the “Res” figure varies by more than 20 percent over the average of 
multiple detector calibrations, move the analyzer away from 
potential interference sources (as discussed in item 6 above), and 
repeat the detector calibration steps. If the resolution does not 
return to its standard range, please contact Thermo Scientific Niton 
Analyzers toll-free at (800) 875-1578 (US only), +1 978 670-7460 
(outside US), via email at niton@thermofisher.com, or your local 
Niton Analyzer representative for assistance.

Plastics 8. From the Main Menu, select Mode -> Consumer Goods Mode -> 
Plastics Mode.

Figure 4-13. Mode Screen 
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Figure 4-14. Consumer Goods Mode

a. Place the Reference Sample (PN 180-619) in the test stand for 
analysis, or set the reference sample on a clean surface. The 
unlabeled side should be presented to the analyzer. Place the front 
end of the instrument against the sample with the window centered 
on the sample. Due to the length of this check measurement, it is 
recommended that a test stand be used. It can be difficult to hold 
the analyzer steady on the reference sample for the required length 
of time.

b. Take one to three 60-source second measurements on this reference 
sample. Ensure that the analyzer has the maximum test time set to 
60 (seconds). From the Main Menu, select Common Setup -> 
Instrument Setup -> Hardware Setup. Edit the Max. Time dialog 
box to the proper setting. Average the results. Results can be 
averaged via the TOOLS drop down menu.

c. Compare the averaged results with the acceptable ranges as listed in 
Table 1. The averaged results should fall within these specified 
values.

*Please refer to the certificate accompanying the reference sample for actual elemental com-
position data as the concentration may vary from batch to batch.

** Please note that mg/kg is a unit of measure of concentration equal to ppm b y mass, i.e.,
1000 ppm is equivalent to 1000 (mg/kg) = 0.1%.

Table 4-1. Plastic “Reference Sample in PE Matrix” Nominal Concentrations and Allowable Ranges

Element Nominal Concentration* 
(mg/kg)**

Acceptable Range (±% 
Rel)

Acceptable Range 
(mg/kg)

Pb 1 50 15% 127-173
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d. If the analyzer reports values within the acceptable ranges of the 
reference values, it is ready for measurement of unknown samples. 
Proceed to Analysis of Unknown Samples section.

e. If the analyzer reports values outside the acceptance tolerance ranges 
specified in Table 4-1, repeat the detector calibration described in 
step 7, then repeat the reference sample analysis in step 8a

f. If the analyzer again fails to meet the acceptance tolerance ranges 
specified in Table 4-1, please contact Thermo Fisher Scientific or 
your local representative for assistance.

If lead is in a surface coating the Painted Products mode should be used.

Caution Only use Painted Products mode for consumer goods (toys, 
apparel, etc). Do not use Standard Mode or K+L Mode for analysis of 
painted samples not associated with building materials. Do not use Painted 
Products mode for analysis of building materials.

Follow the procedure outline in step 8.1, but using the Painted Products 
standard.

*Please refer to the certificate accompanying the reference sample for actual elemental com-
position data.

** Please note that the standard used (green paint) is reported in milligrams/cm². 0.30 milli-
grams/cm² is equal to 300 micrograms/cm².

Action Levels Painted Products mode allows the XRF instrument to be used to its full 
advantage, namely as a rapid and non-destructive test. This mode enables a 
direct positive/negative comparison against the new alternative standard of 2 
micrograms/cm² The value of the action level can be set from 2 
micrograms/cm² to 9 micrograms/cm², with 2 micrograms/cm² set by 
default. To change the default value follow the following procedure:

Table 4-2. Painted Products “Lead Reference Sample” Nominal Concentrations and Allowable Ranges

Element Nominal Concentration* 
(micrograms/cm2 )**

Acceptable Range (±% 
Rel)

Acceptable Range 
(micrograms/cm2)

Pb 3 00 15% 255-345
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From the Main Menu, select Mode -> Consumer Goods -> Set Action Level

Figure 4-15. Toy Paint Action Level Screen

There is no correlation between micrograms/cm² and ppm, although some 
research indicates that the value of 1 micrograms/cm² to 9 micrograms/cm² 
roughly correlates to Pb concentrations in dried paint of 50 ppm to 600 
ppm, respectively. However it is important to point out that these are 
alternate measurements set by the regulators, which means that they don’t 
have to agree with each other to be valid.

When using plastics mode, results are reported in ppm (mg/kg). A 
pass/fail/inconclusive can be setup to correlate with a certain action levels. 
Based on the current regulation (as of March of 09), the action level for Pb 
in consumer products is 600 ppm (300 ppm in August 2009). Given the 
variability of the samples and the number of possible ways of presenting the 
sample to the analyzer, the pass criteria should be set lower than 600 ppm. 
While performing screening activities, we recommend that the 
identification of any Pb in a sample should alert the user to the need for 
additional testing to determine true content and location of Pb in the 
sample; setting the pass/fail level to 100 ppm (factory default) would allow 
this. To change factory default settings, follow the following procedure:
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From the Main Menu, select Common Setup -> Element Display Options 
-> Set Element Threshold -> Plastics Mode

Figure 4-16. Plastics Mode Pass/Fail Action level settings

Analysis of Unknown
Samples

Toys and the majority of other consumer products represent a wide variety 
of material composition, shapes, and functionality. Plastic, wooden, and 
paper goods should be tested using Plastic Mode. Products and components 
made of a combination of metallic and nonmetallic parts (materials) should 
be tested using Plastic Mode. Painted objects should be tested in the Painted 
Products Mode.

Note The following text applies to the use of a Niton XLp 300 Series XRF 
analyzer with Consumer Goods mode.

All parts of a product should be screened for the restricted element of lead 
using the appropriate analytical mode. The primary goal of screening is not 
to accurately analyze the chemical composition of all components or parts of 
the product, but to weed out and eliminate from the market products 
containing lead. Therefore, it is only logical to start testing the product “as 
is”, without disassembly. This is particularly true of the products that are 
painted because lead can typically be found in paint. Once the presence of 
lead is confirmed during testing “as is”, the product can be sequestered, and 
further testing may not be necessary. If, however, the testing of the product 
“as is” produces no evidence of lead, but it is suspected that it may be 
contained in inaccessible parts of the product for direct “as is” testing, one 
must consider disassembly of the product for compliance testing at the 
component level. If the product or its components are large enough, they 
may be tested directly by pressing the analyzer against their surfaces. 
Otherwise, measurements should be performed in a test stand.
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Due to the large variety of consumer products, only general rules of testing, 
related mainly to proper sample selection and results interpretation, are 
outlined here. Detailed testing protocols should be developed for specific 
cases by the user.

General Testing Protocol

Large Objects These are the objects that can easily cover the measuring window of the 
analyzer and are typically at least as large as the analyzer.

1. Remove the foam from the upper part of the Niton XLp 300 
Series analyzer..s carrying case.

2. Place the In-Situ Test Guard on the analyzer. This test guard is 
used to help enable the front proxity button as required during 
measurement.

3. Select the areas or fragments of the sample that is to be tested.

a. Based on the type of material, select appropriate analytical mode:

i. Plastic Mode for all nonmetallic materials (or if uncertain of 
material)

ii. Painted Products mode for painted surfaces on materials.

4. Place the measuring window of the analyzer flush within the area 
identified on the toy or product for analysis and pull the trigger 
to start measurement.

5. Figures 4-17, 4-18 and 4-19 show examples of positioning the 
materials to be measured.

6. Continue the measurement until the display says PASS or FAIL. 
While a FAIL may appear immediately when a sample contain 
high levels of Pb, it is advisable to analyze all samples for a 
minimum amount of time for consistency purposes. The 
minimum time may be 30 to 60 source seconds. Experience with 
continued sampling can help determine what is best for your 
application.
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7. Figures 4-20 to 4-23 show the results screen for each mode.

8. When testing larger surfaces, it is advisable to take several 
measurements at different locations. This is especially important 
if the surface tested is partially painted, plated, or otherwise 
appears different from location to location, including areas with 
different color paints. This will help in identifying the location of 
any Pb found during the screening, whether in the substrate, 
paint, or both.

9. If the foam is not used for the measurement, insure that the 
surface holding the object being tested does not contain lead by 
testing the surface prior to screening unknown samples.

10. The object being tested should be at least one inch (2 centimeters) 
in thickness.

11. Continue the measurement as planned.

Figure 4-17. Screening a larger object. 
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Figure 4-18. One possible way of screening a toy.

Figure 4-19. The sweater is placed on the table for measurement. 
Ensure the table has no lead by first measuring it with the 
analyzer.
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Figure 4-20. The results screen shows a positive result for lead in 
paint.

Figure 4-21. Inconclusive reading for this plastic item. A high levels 
of Pb appears to be present but more time is needed for 
the measurement at the current threshold limit to 
conclusively determine that the result is positive.
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Figure 4-22. The result indicates fail (action level set at 100 ppm)

Figure 4-23. The result indicates pass (action level set at 100 ppm)
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Small Objects These are objects that are typically smaller in size than analyzer, but still 
large enough to cover the measuring window of the analyzer.

1. The foam may be used as in the protocol for the Large Objects.

a. Optionally, place the object in a test stand in such a way that the 
area selected for testing covers the measuring aperture of the 
instrument as much as possible. If the toy cannot be manipulated 
into a position suitable for measurement, one may need to use some 
small objects to support the object in proper position.

Figure 4-24. The figure is positioned so that the item in Figure 15 is 
balanced on its side, 
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Figure 4-25. The item is placed on the foam supplied in the top of the 
instrument carrying case

A second option is to use a test stand (not supplied)

Figure 4-26. Niton XLp 300 Series shown with optional portable 
(part #500-961) and bench-top (part #600-705) test stands
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b. First select the areas or fragments of the object that are to be tested.

c. Mount the analyzer in a test stand and connect the analyzer to a PC 
(via Serial Cable, or via Bluetooth). Start the NDTr Program on PC.

d. Place the object in a test stand in such a way that the area selected 
for testing covers the measuring aperture of the instrument as much 
as possible. If the toy cannot be manipulated into a position suitable 
for measurement, one may need to use some small objects to 
support the object in proper position. Common, small rubber 
erasers were found suitable and convenient for such task. Care must 
be taken to not allow any part of the support to be within the 
perimeter of the measuring window of the analyzer. Figures 4-27 
and 4-28 show examples of how the object can be manipulated into 
proper testing position.

e. Based on the type of material, select appropriate analytical mode:

i. Plastic Mode for all nonmetallic materials and combinations of 
nonmetallic

ii. Painted Products Mode for painted surfaces.

f. Start the measurement, preferably via a PC using the NDTr software 
program.

g. Continue the measurement until the display says PASS or FAIL.

h. If possible, take more than one measurement of the sample, 
preferably in a different location.

2. Continue measurements as planned.
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Figure 4-27. The unpainted bulk of the dinosaur’s foot 

Figure 4-28. Positioning the sample for analysis may require a 
helping hand
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Very Small Objects These are objects that are not large enough to cover the analyzer measuring 
window, typically less than 10 mm in any dimension, e.g., beads, small 
jewelry pieces, chains, etc. 

1. Mount the analyzer in a test stand and connect it to PC (via Serial 
Port or Bluetooth). Start NDTr software program on user’s PC.

2. Stretch taut a piece of Mylar film (Part Number 187-462) over 
the measuring aperture of the analyzer and secure it with tape.

3. Place the object in a test stand in such a way that it resides in the 
center of the measuring window of the analyzer. If available, it is 
possible to take more than one identical small item and pile a 
small quantity of them over the measuring window of the 
analyzer. However, one must be certain that these individual 
items are identical in composition.

4. Based on the type of material, select appropriate analytical mode:

a. Plastic Mode for all nonmetallic materials 

b. Painted Products Mode for paint on consumer products.

5. Start the measurement, preferably using NDTr.

6. Continue the measurement until the display says PASS or FAIL.

7. Continue measurements as planned.
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Chapter 5 Thin Sample Test Modes

You can use your NITON XLp Environmental Analyzer to measure a wide 
range of thin samples, such as: 

• 25 mm and 37 mm diameter filters used for exposure monitoring 
and air sampling methods. 

• Total Suspended Particulate (TSP) and Particulate Monitoring (PM) 
filters. 

• Dust Wipes. 

• Thin coatings, depending on the substrate. 

• Filters used for capturing suspended or dissolved metals in liquids 

There are specific procedures for specific applications. Methods for many of 
these applications have been developed and may be selected from the Thin 
Sample Mode Menu. Other applications, such as analyzing coatings, may 
require you to develop your own protocol using User-definable Thin Sample 
Mode, which is also available from the Thin Sample Mode Menu.

Using Thin Sample
Test Modes

The methods you can select have been developed to account for the size of 
the sample and the distribution of the contamination to be analyzed. 
Contamination captured on filters or wipes is not usually deposited 
uniformly, and as filters and wipes are also several times larger than the 1 cm 
x 2 cm measurement window of the instrument, these sample types usually 
require reading on separate sections for accurate analysis. 

Depending on the sample, the individual readings may be first weighted to 
account for the loading characteristics of the sampling technique, and then 
all the individual reading in a sequence are either summed or averaged. This 
result is multiplied by an adjustment factor to account for the size of the 
sample and the desired units of measurement, so the final results are 
displayed with an easily interpreted meaning. (e.g. dust wipes, which are 
used extensively to test for Pb dust on surfaces report in g/wipe, which is 
easily converted to g/foot2, the units specified in state and federal 
regulations.) These calculations will be performed automatically when you 
choose the appropriate Thin Sample Mode from the Thin Sample Mode 
Menus.
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The Tools Menu

Figure 5-1. The Tools Menu

The Tools Menu enables you to perform common data-related tasks such 
as printing and averaging. Select a task from the drop down menu to ini-
tiate that task.

The Tools Menu, like the NAV Menu, uses context sensitive menus. The 
following is the most common menu set.

Print Enables you to print the sample analysis to the attached printer.

Backlight Enables you to turn backlighting on and off.

Avg Forward Enables you to average different readings together from this analysis 
forward. Select Avg Forward to initiate future sample averaging. Avg 
Forward will set up an automatic personal averaging protocol to be followed 
until your analyzer is shut down. To begin, select the number of readings 
you want to average from the virtual numeric keypad. Your analyzer will 
calculate an average reading after that number of tests, and continue this 
pattern until stopped. For example, if you select 3 on the virtual keypad, the 
analyzer will automatically calculate, average, and store a reading for every 
three tests you take.
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Avg Back Enables you to average different readings together from this analysis 
backward. Select Avg Back to initiate backwards sample averaging. Avg Back 
will take a number of readings you select and average their analytical results. The 
range is counted from the last reading backward by the number of readings 
selected. If your last reading was #15, selecting 3 would average readings 
#13, 14, and 15. The average is calculated, displayed, and stored into 
memory as the next sequential reading number.

Note You cannot average readings taken with different modes - or with 
different sources if they have different element lists - with either Avg Back or 
Avg Forward. Alloy and Mining modes use the same element lists with the 
different sources, so averaging works when switching between sources in 
either of these modes. Thin Film and Bulk modes both use different 
element lists for different sources, and readings with different sources cannot 
be averaged when using either of these modes. 

Note The Tools Menu is only available when viewing readings, and the 
menu is only accessible through the touch screen interface or NDTr. 

The range number is selected using a virtual keypad on your analyzer similar 
to the keypad used for login. Select the digits in the range number from the 
keypad, then select the “E” key to enter the number. “C” will clear all, and 
“<“ will clear the last digit entered. The average will automatically be 
displayed.

Figure 5-2. Set Range Number Screen
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Stop Avg Fwd/Back

Figure 5-3. Stop Average Tool

Avg Back and Avg Forward are toggles. The option on the Tools Menu 
changes to its opposite when selected. To stop averaging, select Stop Avg 
Fwd or Stop Avg Back from the Tools Menu as appropriate.
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Example Averaging

Figure 5-4. Averaging four readings
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The Thin Sample
Mode Menu

Figure 5-5. The Thin Sample Mode Menu

All NITON XLp Thin Sample Mode functions are accessible from the Thin 
Sample Mode Menu and subsidiary menus. Each of the instrument 
functions represented by an icon on the Thin Sample Mode Menu screen 
may be selected by choosing the appropriate icon. When one of these Thin 
Sample Mode Menu icons is selected, the function specific sub-menu 
appropriate to that icon will be displayed.

To use the Dust Wipe Testing Mode, simply select the Dust Wipe icon from 
the Thin Sample Mode Menu to place your instrument into Dust Wipe 
Testing Mode.

To use the 37mm Filter Testing Mode, simply select the 37mm Filter icon 
from the Thin Sample Mode Menu to place your instrument into 37mm 
Filter Testing Mode.

To use the 25mm Filter Testing Mode, simply select the 25mm Filter icon 
from the Thin Sample Mode Menu to place your instrument into 25mm 
Filter Testing Mode.

To use the Standard Filter Testing Mode, simply select the Standard Filter 
Mode icon from the Thin Sample Mode Menu to place your instrument 
into Standard Filter Testing Mode.
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To use the TSP Filter Testing Mode, simply select the TSP Filter Mode icon 
from the Thin Sample Mode Menu to place your instrument into TSP 
Filter Testing Mode. At the time this User's Guide was published, the TSP 
Filter Testing Mode was not available on the NITON XLp Analyzer. 

For more information on this feature, please contact Thermo Scientific's 
Customer Service Department in the United States, toll free, at (800) 
875-1578, or outside the United States, at +1-978-670-7460 or your local 
Authorized NITON Analyzers Service Center.
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Dust Wipe Testing
Mode Menu

Figure 5-6. Dust Wipe Mode Testing Menu

From the Dust Wipe Testing Menu, you can immediately initiate a sample 
test using the proper preconditions for operation, enter data about your 
sample using the Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the Dust Wipe Testing Menuto go to 
the “The Data Entry Screen” on page 5-24, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

The Dust Wipe Mode prompts you to take four readings on a properly 
folded and bagged dust wipe, which are then averaged to give you a final test 
result.Dust wipes are usually analyzed for Pb, though many other 
contaminants may also be detected. 

The wipe recommended by NITON is the Lead Wipe. If the use of other 
brands is desired, consult with NITON prior to any testing. 

Note Some brands of wipes are not compatible with the NITON method. 

Lead Wipes are available from Thermo or from: 

Lynx Products

Thorofare, New Jersey
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(800) 767-6933

The following instructions are appropriate for screening purposes. The 
instrument displays levels of contamination in μg per wipe. The wipe 
reflects the levels of contaminants of the area wiped. Current regulations 
require lead contamination below 40 μg/ft2 on floors, 250 μg/ft2 on window 
sills, and 400 μg/ft2 in window wells. 

Note Check with all local, state and federal regulatory bodies, as the 
regulations may change from location to location, and from time to time. 

Taking a Dust Wipe
Sample

NITON assumes that you will follow the HUD guidelines for taking a dust 
wipe which are summarized here: 

1. Measure a known area of the surface, preferably one square foot 

2. Wear clean surgical gloves. Wipe the measured square with 
parallel strokes 

3. Fold the wipe in half. Wipe in strokes 90° to the original 
direction. 

4. Fold the wipe in half again. 

Note Thus far, you have followed one of the HUD procedures for taking a 
wipe test. The following procedure is specific for testing with your 
instrument, though it will not affect your results should you decide on 
submitting the sample to an accredited laboratory. 

5. Fold the wipe in half three more times. You will now have a pad 
measuring about 1 x 1.5 inches (2.5 x 3.7 cm). It is important to 
fold the wipe neatly, so that the final wipe is very nearly a neat 
rectangle measuring about 1 x 1.5 inches. 

6. Place the folded wipe in one of the plastic baggies provided 

7. Position the wipe, in the baggie, in the metal dust wipe holder 
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8. The dust wipe is now ready to test. NITON recommends that the 
plastic bags NOT be re-used, to eliminate the chance of 
cross-contamination of subsequent wipes. 

Taking Measurements of
Your Dust Wipe Sample

Follow the procedure below: 

1. Position the metal dust wipe holder on the number one position of 
the test stand. 

2. Position the instrument in the nose cone adaptor and initiate the 
first measurement. 

3. Place the wipe in the number two position of the test stand. Take 
the second measurement. 

4. Rotate the dust wipe holder 180 degrees (without turning the 
holder over). 

5. With the wipe in the number one position, take the third 
measurement. 

6. Change the wipe to the number two position. Take the fourth 
measurement. 

This procedure assures that your analyzer measures the entire area of the 
folded dust wipe. 
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Reading The
Measurement and Final

Results Screens

The Measurement screen is continually updated during each test. When 
each test is terminated, the screen will update one final time and store the 
results for future review or downloading. After the fourth step of the test 
sequence is complete, the Final Results screen will appear. 

When the four measurements are complete, the instrument automatically 
averages the results to yield the average loading in μg/wipe. These results are 
displayed on the Final Result screen. (Note that Figures 5-7 & 5-8 show 
multiple elements measured on a dust wipe sample.  NITON 300 Series 
Analyzers will only display results for Pb.)

Figure 5-7. Reading the Final Results Screen
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Units of Measure

Two Sigma

Element Detected

Measured Quantity

Reading Number

Confidence Column
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Figure 5-8. All Four Dustwipe Reading Screens
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37mm Testing Mode
Menu

Figure 5-9. 37mm Testing Mode

From the 37mm Testing Menu, you can immediately initiate a sample test 
using the proper preconditions for operation, enter data about your sample 
using the Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the 37mm Testing Menuto go to the 
“The Data Entry Screen” on page 5-24, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

Preparing a filter 37 mm filters are often used for monitoring personal exposure. Dust 
vacuum measures (DVM) use the same size filters and are tested in much 
the same way. To prepare the filter for testing, remove it from the 
air-sampling cassette and load it in the correct sized filter sleeve. The filter 
sleeve consists of a thin piece of cardboard sandwiched between two layers of 
plastic film. The circular cutout in the cardboard should be slightly larger in 
diameter than the filter. 

Note To avoid contaminating the test results, wear clean surgical gloves 
when handling the filter. If using tweezers or forceps to handle the filter, 
make certain they are clean, and never reuse a filter sleeve. 

1. On a clean surface, take a filter sleeve and peel back the top layer 
of film. 
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2. Remove the bottom plug from the air sampling cassette. Separate 
the sections of the cassette so you can reach the filter. 

3. Poke both the filter and filter pad through the outflow plug hole 
of the cassette, to release them from their seat in the cassette. 

4. Touching only the edges of the filter and the pad, gently separate 
one from the other. 

5. Lift the filter from the cassette and place it on the sleeve in the 
cutout. Be careful not to have the filter touch the paper mounting 
of the sleeve, as the light adhesive that holds the plastic in place 
may rip the filter. 

6. Fold back the clear plastic of the filter sleeve, covering the filter. 
A little wrinkling of the plastic is acceptable. 

Note It is advisable to practice mounting several blank filter cassettes prior 
to mounting your first test sample. 

Positioning the 37 mm
Filter and Performing a

Test.

Note Make certain to place the filter stand on a flat stable surface. Be careful 
to work on a surface which will not contaminate the test fixtures or samples. 


1. Remove the drawer from the test platform. Verify that the 
adaptor for holding 37 mm filters is in place. Insert the filter 
sleeve with the filter to be tested in position A of the adaptor, and 
slide the drawer back into the test stand. 

Note Testing order is essential: The first reading must be taken from 
position A. 

2. Select the Thin Sample Mode Select menu, and then choose 
37mm CE Filters icon 

3. Position the instrument in the nose cone adaptor and initiate the 
first reading. 
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You must take three readings, each from a different area of the filter to 
accurately determine the concentration of elements on the filter. When the 
desired test time has elapsed, remove the instrument to end the first test. 
The instrument will beep at 60 nominal (or source) seconds, unless pre set 
otherwise by the user, which is typically an adequate test time for the 
precision of the measurement to detect the presence of many contaminants 
at their action levels. 

Note If concentrations of the elements of concern are significantly above the 
action level, the tests lengths may be shortened at the users discretion. 

4. Remove the drawer and change the filter to position B. 

5. Repeat the above sequence to take the second test. 

6. When the second test is complete, remove the drawer and 
position the test sleeve in position C and take a third 
measurement. 

The instrument will automatically calculate the contaminant loading, in μg, 
after the three readings have been completed.

Reading The
Measurement Screen in

37mm Testing Mode

The Measurement screen is continually updated during each test. When 
each test is terminated, the screen will update one final time, display the 
phrase Final Results, and store the results for future review or downloading. 
37mm Testing Mode reports in units of μg of loading, and using the 
volumetric flow rate and airsampling time, the results can be converted to 
μg/m3 concentrations.
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Figure 5-10. All Three 37mm Reading Screens
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25mm Testing Mode
Menu

Figure 5-11. 25mm Testing Mode Menu

From the 25mm Testing Menu, you can immediately initiate a sample test 
using the proper preconditions for operation, enter data about your sample 
using the Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the 25mm Testing Menuto go to the 
“The Data Entry Screen” on page 5-24, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

Preparing a filter 25 mm filters are often used for monitoring personal exposure. Dust 
vacuum measures (DVM) use the same size filters and are tested in much 
the same way. To prepare the filter for testing, remove it from the 
air-sampling cassette and load it in a the correct sized filter sleeve. The filter 
sleeve consists of a thin piece of cardboard sandwiched between two layers of 
plastic film. The circular cutout in the cardboard should be slightly larger in 
diameter than the filter. 

Note To avoid contaminating the test results, wear clean surgical gloves 
when handling the filter. If using tweezers or forceps to handle the filter, 
make certain they are clean, and never reuse a filter sleeve. 

1. On a clean surface, take a filter sleeve and peel back the top layer 
of film. 
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2. Remove the bottom plug from the air sampling cassette. Separate 
the sections of the cassette so you can reach the filter. 

3. Poke both the filter and filter pad, through the outflow plug hole 
of the cassette, to release them from their seat in the cassette. 

4. Touching only the edges of the filter and the pad, gently separate 
one from the other. 

5. Lift the filter from the cassette and place it on the sleeve in the 
cutout. Be careful not to have the filter touch the paper mounting 
of the sleeve, as the light adhesive that holds the plastic in place 
may rip the filter. 

6. Fold back the clear plastic of the filter sleeve, covering the filter. 
A little wrinkling of the plastic is acceptable. 

Note It is advisable to practice mounting several blank filter cassettes prior 
to mounting your first test sample. 

Positioning the 25 mm
Filter and Performing a

Test.

Note Make certain to place the filter stand on a flat stable surface. Be careful 
to work on a surface which will not contaminate the test fixtures or samples. 


1. Remove the drawer from the test platform. Verify that the 
adaptor for holding 25 mm filters is in place. Insert the filter 
sleeve with the filter to be tested in position one of the adaptor, 
and slide the drawer back into the test stand. 

Note Testing order is essential: The first reading must be taken from the 
middle of the filter. 

2. Select the Thin Sample Mode Select menu, and then choose 
25mm CE Filters icon 

3. Position the instrument in the nose cone adaptor and initiate the 
first reading. 
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The instrument will automatically calculate the contaminant loading, in 
mg, after the reading has been completed. 

Reading The
Measurement Screen in

25mm Testing Mode

The Measurement screen is continually updated during each test. When 
each test is terminated, the screen will update one final time, display the 
phrase Final Results, and store the results for future review or downloading. 
25mm Testing Mode reports in units of μg of loading in just minutes, and 
using the volumetric flow rate and airsampling time, the results can be 
converted to μg/m3 concentrations. 

Figure 5-12. 25mm Finalt Results Screen
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Mode Menu

Figure 5-13. Standard Testing Mode Menu

From the Standard Testing Menu, you can immediately initiate a sample 
test using the proper preconditions for operation, enter data about your 
sample using the Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the Standard Testing Menuto go to the 
“The Data Entry Screen” on page 5-24, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

You should use Standard Thin Sample Mode to test thin samples that have 
uniform contamination or deposition. These include many filters for liquids 
and gases, various types of coatings, and the leaves of plants. Operators who 
want to make a single measurement and obtain a result in units of μg/cm2 

should use Standard Thin Sample Mode. 

CAUTION Standard Thin Sample Mode should not be used for 
quantitative lead-paint testing. Use only the three Paint Testing modes to 
test lead-based paint. 

In Standard Thin Sample Mode, each measurement is a separate test. For 
this reason, there is no Final Result screen in this mode. The results of each 
test are given in μg/cm2 for up to 14 elements. 
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Note Testing coatings and paints with Standard Thin Sample Mode may 
yield lower-than-actual results. The penetration depth of the measurement 
is highly dependent on the composition of the sample. 

Note Standard Thin Sample Mode does not correct for shielding caused by 
the presence of overlaying coatings. Thus, for coatings testing, the results 
should be viewed as the minimum amount of contaminants present. If an 
element is not detected, it may be that the element is present but entirely 
shielded by overlaying coatings. 

Reading The
Measurement Screen in
Standard Thin Sample

Mode

The Measurement screen is continually updated during each test. When 
each test is terminated, the screen will update one final time, display the 
phrase Final Results, and store the results for future review or downloading. 
Standard Thin Sample Mode reports in units of μg/cm2

Figure 5-14. The Final Reading Screen for Standard Thin Sample 
Mode

For more information on this feature, please contact NITON's Customer 
Service Department in the United States, toll free, at (800) 875-1578, or 
outside the United States, at +1-978-670-7460 or your local Authorized 
NITON Analyzers Service Center.
Thermo Scientific NITON XLp Analyzer User’s Guide 21



Thin Sample Test Modes
Analyzing Thin Samples
Analyzing Thin
Samples

CAUTION After being powered on, the NITON 300 Series Analyzer will 
perform an internal re-calibration before an analysis is initiated.  It is 
recommended that you let your instrument warm up for ten minutes after 
start up, before testing is begun. 

There are five different methods of operation for taking a sample 
measurement, and your analyzer will be configured to use one of those 
methods, depending on the regulatory requirements of your locality. These 
methods are:

• Trigger-Only method. With the Trigger-Only method, you only need to 
place the measurement window close to the sample to be analyzed and 
pull the trigger for sample analysis to be initiated. 

• Trigger-and-Proximity-Sensor method. With the 
Trigger-and-Proximity-Sensor method, you must place the measurement 
window against the sample to be analyzed to engage the proximity 
sensor on the front of the instrument, then pull the trigger for sample 
analysis to be initiated.

• Momentary-Trigger-Touch-and-Proximity-Sensor method. With the 
Momentary-Trigger-Touch-and-Proximity-Sensor method, you must 
place the measurement window against the surface to be analyzed to 
engage the proximity sensor on the front of the instrument, then pull 
the trigger.

• The trigger may be released and the reading will continue until you 
release the proximity button, or other criteria (such as Max Time) are 
reached. This is the primary mode of operation for the XLp 300A/700A 
Series Lead-in-Paint Analyzer in the USA.

• Trigger-and-Interlock method. With the Trigger-and-Interlock method, 
you need to place the measurement window close to the sample to be 
analyzed, press and keep pressing the interlock button at the rear of the 
instrument with your free hand, then pull the trigger for sample analysis 
to be initiated.

• Trigger-Interlock-and-Proximity-Sensor method. With the 
Trigger-Interlock-and-Proximity-Sensor method, you must place the 
measurement window against the sample to be analyzed to engage the 
proximity sensor on the front of the instrument, press and keep pressing 
the interlock button at the rear of the instrument with your free hand, 
then pull the trigger for sample analysis to be initiated.
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With any of these methods, analysis will stop if any one of the preconditions 
are violated. For example, with the Trigger-Interlock-and-Proximity-Sensor 
method, if the trigger or the Proximity Sensor or the Interlock is released, 
the reading will stopimmediately, and the shutters will close.

After your NITON XLp analyzer is calibrated, initiate a sample reading 
using the appropriate method. If you attempt to initiate a sample reading 
using a different method, the analyzer will inform you that one or more of 
the preconditions need to be met in order for sample analysis to begin. 

WARNING!  The three LED warning lights are designed to blink only 
during a measurement, where one or more of the shutters are open and the 
trigger depressed. If the LED lights blink at any other time, disconnect the 
battery pack immediately, place the instrument in its shielded holster, place 
the holster in the shielded carrying case, and call NITON LLC’s Service 
Department in the United States, toll free, at (800) 875-1578, or outside 
the United States, at +1-978-670-7460, or your local Authorized NITON 
Analyzers Service Center. 

WARNING! The preconditions for operation must be continued for the 
duration of the reading. If the preconditions are violated, all the shutters will 
close, and the measurement will end. The three LED lights will stop 
blinking, the shutters will close, and the measurement will end. The flashing 
of the LED lights is not synchronized to minimize power consumption. 

Your NITON Analyzer will display the Results Screen throughout the 
duration of each reading, The Results Screen is updated regularly 
throughout the reading. When the reading is complete, a final screen update 
will appear, and your NITON analyzer will display the final results of the 
measurement which has just been completed.
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The Data Entry
Screen

The Data Entry Screen is accessed whenever you select the Data Entry icon 
from any screen. This screen allows you to input data in several different 
fields, or categories, concerning your sample, in several different ways:

• By selecting the Virtual Keyboard button and typing the parameter in 
using the Virtual Keyboard. 

• By scanning in the parameter name using the integrated bar code 
scanner.

• By creating a new, or editing your analyzer's existing, '.ndf' file through 
the NDT program. You can then select from the various custom options 
you have created using the Drop-down List button.

These fields are saved along with the subsequent reading, and allow you to 
associate important information about the sample directly with the reading, 
so that you have a full description of the sample tied into the reading itself.

Once you have input data into a field, that information carries over into the 
next reading, so that you only have to input the information that has 
changed since the last reading. For example, if you are analyzing several 
samples of a particular lot, you only need to input the lot information once 
during that series of readings, changing only the sample name.

Figure 5-15. Data Entry Screen 1
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This is the first section of the Data Entry Screen. There are five parameters 
in this section.

• Selecting Sample allows you to input the sample name parameter

• Selecting Location allows you to input the particular location 
information, if known

• Selecting Inspector allows you to specify the inspector.

• Selecting Condition allows you to input information on the 
sample’s condition

• Selecting Type allows you to specify the sample’s type

.

Figure 5-16. Data Entry Screen 2

This is the second section of the Data Entry Screen. There are two 
parameters in this section.

• Selecting Misc allows you to input miscellaneous parameters

• Selecting Note allows you to input notes on the sample
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Navigating the Data
Entry Screen

Figure 5-17. The Control Panel

The following description of screen navigation using the control panel 
assumes that the analyzer is held so that the display is held upright as in 
Figure 5-17.

• To move from column to column, use the Right and Left portion of the 
4-way touch pad.

• To move from row to row, use the Up and Down portions of the 4-way 
touch pad.

• To select the highlighted option, press the Enter button on the control 
panel. 

The Data Entry Screen is divided into sections of 5 setting parameters. By 
using the Down portion of the 4-way touch pad when you are on the last 
row of a section, the display will change to the next section. By using the Up 
portion of the 4-way touch pad when you are on the first row of a section, 
the display will change to the previous section. 

By selecting the On/Off button, you can exit the Data Entry Screen.

Touch Screen 
Display

On/Off 
Button

Down

Right

4-way
 touch-pad

Up

Enter
Button

Left
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The Virtual Keyboard

Figure 5-18. The Virtual Keyboard

The Virtual Keyboard is a full alphanumeric keyboard which appears on the 
LCD Touch Screen Display. You can use the Virtual Keyboard either with 
the four-way touch pad and control panel buttons, or using the touch screen 
display directly. 

At the top of the screen is the data field you are entering data for, in this 
case, “Sample”, Directly underneath is the data you are entering, in this case 
“17-4 PH SS”, On this line also is the underscore cursor. This graphically 
shows where the next character will be placed. Up to 25 characters can be 
stored in the data fields.

Lower Case Virtual Keyboard

Upper Case Virtual Keyboard
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Next is the Virtual Keyboard itself, with numbers 0-9, letters A-Z, and 
special characters *,<,>, and -.

Last is the control button line. This contains the screen buttons for Return 
and Clear.

When using the four-way touch pad and control buttons, pressing the 
On/Off button allows you access to the Return and Clear screen buttons. 
The Return screen button will enter the data and return you to the Data 
Entry Screen, while the Clear screen button will clear the data you have 

All screen areas can be directly accessed using the LCD Touch Screen.
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NITON Test
Platforms

Figure 5-19. NITON Bulk Mode Test Stand

The NITON Bulk Test Stand is designed to facilitate bulk and thin sample 
testing using NITON Analyzers.The NITON Portable Test Stand is 
designed for bulk and moderate sized samples, and is portable.

Nose Cone
Adapter

Release Button
Test Surface Cutout

Support Arm

Sample Storage Tray Sample Test 
Analysis
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Lever
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Drawer
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Post
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Figure 5-20. NITON Portable Test Stand

Sample Test Area

NITON Analyzer
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Chapter 6 Bulk Sample Test Modes

Using Bulk Sample
Test Modes

Bulk Sample Test Modes allow you to test soils and other ground samples 
for composition and contamination. Your NITON XLp Analyzer may be 
used for soil and bulk analysis, either in-situ or ex-situ. 

The Tools Menu

The Tools Menu, like the NAV Menu, uses context sensitive menus. The 
following is the most common menu set.

Figure 6-1. The Tools Menu

Print Enables you to print the sample analysis to the attached printer.

Backlight Enables you to turn backlighting on and off.
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Avg Forward Enables you to average different readings together from this analysis 
forward. Select Avg Forward to initiate future sample averaging. Avg 
Forward will set up an automatic personal averaging protocol to be 
followed until your analyzer is shut down or Averaging is turned off. To 
begin, select the number of readings you want to average from the virtual 
numeric keypad. Your analyzer will calculate an average reading after that 
number of tests, and continue this pattern until stopped. For example, if 
you select 3 on the virtual keypad, the analyzer will automatically calculate, 
average, and store a reading for every three tests you take.

Avg Back Enables you to average different readings together from this analysis 
backward. Select Avg Back to initiate backwards sample averaging. Avg 
Back will take a number of readings you select and average their analytical results. 
The range is counted from the last reading backward by the number of 
readings selected. If your last reading was #15, selecting 3 would average 
readings #13, 14, and 15. The average is calculated, displayed, and stored 
into memory as the next sequential reading number.

Figure 6-2. Averaging Screen
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Note You cannot average readings taken with different modes - or with 
different sources if they have different element lists - with either Avg Back or 
Avg Forward. Alloy and Mining modes use the same element lists with the 
different sources, so averaging works when switching between sources in 
either of these modes. Thin Film and Bulk modes both use different 
element lists for different sources, and readings with different sources cannot 
be averaged when using either of these modes. 

Note The Tools Menu is only available when viewing readings, and the 
menu is only accessible through the touch screen interface or NDTr. 

The range number is selected using a virtual keypad on your analyzer similar 
to the keypad used for login. Select the digits in the range number from the 
keypad, then select the “E” key to enter the number. “C” will clear all, and 
“<“ will clear the last digit entered. The average will automatically be 
displayed.

Figure 6-3. Set Range Virtual Keypad
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Stop Avg Fwd Avg Forward is a toggle. The option on the Tools Menu changes to its 
opposite when selected. To stop averaging, select Stop Avg Fwd from the 
Tools Menu.

Figure 6-4. Stop Average Tool
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Averaging Example

Figure 6-5. Example of Averaging
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The Bulk Sample
Mode Menu

Figure 6-6. Bulk Sample Mode Menu

All NITON XLp Bulk Mode functions are accessible from the Bulk Mode 
Menu and subsidiary menus. Each of the instrument functions represented 
by an icon on the Bulk Mode Menu screen may be selected by choosing 
the appropriate icon. When one of these Bulk Mode Menu icons is 
selected, the function specific sub-menu appropriate to that icon will be 
displayed.

To use the Standard Bulk Mode, simply select the Standard Bulk Mode 
icon from the Bulk Mode Menu to place your instrument into Standard 
Bulk Mode. Use the Standard Bulk Mode if:

• The percentage of the elements of interest are <1.0%

• The material is of a light matrix, for example aluminum silicate

• Elements with atomic number greater than iron do not exceed 
several percent

To use the Industrial Bulk Cu/Zn/Pb Testing Mode, simply select the 
Industrial Bulk Cu/Zn/Pb icon from the Bulk Mode Menu to place 
your instrument into Industrial Bulk Cu/Zn/Pb Testing Mode. In 
Industrial Bulk Cu/Zn/Pb Testing Mode, all other programmed 
elements are active in addition to Cu/Zn/Pb (e.g. Ti, Cr, Mn, Fe, Co, Ni, 
Zr, Nb, Mo, W, etc.). Industrial Bulk Cu/Zn/Pb Testing Mode is 
recommended if you know, without a doubt, that your sample contains Cu, 
Zn, and/or Pb and not Ta, Hf, or Re. When your NITON XLp analyzer is 
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operating in Industrial Bulk Cu/Zn/Pb Testing Mode, the NITON XLp 
analyzer will not measure concentrations of Hf, Ta, or Re in a sample. Once 
Industrial Bulk Cu/Zn/Pb Testing Mode is selected, you may begin 
testing samples.

Use Industrial Bulk Cu/Zn/Pb Testing Mode if: 

• There is more Cu/Pb/Zn than Ta/Hf/Re in the sample 

• The percentage of the elements of interest are >1.0%

• The matrix material is not a light matrix

• Elements with atomic number greater than iron (Z = 26) exceed 
several percent

To use the Industrial Bulk Re/Ta/Hf Testing Mode, simply select the 
Industrial Bulk Re/Ta/Hf icon from the Bulk Mode Menu to place your 
instrument into Industrial Bulk Re/Ta/Hf Testing Mode. In Industrial 
Bulk Re/Ta/Hf Testing Mode, all other programmed elements are active 
in addition to Ta, Hf, or Re (e.g. Ti, Cr, Mn, Fe, Co, Ni, Zr, Nb, Mo, W, 
etc.). Industrial Bulk Re/Ta/Hf Testing Mode is recommended if you 
know, without a doubt, that your sample contains Ta, Hf, and/or Re and not 
Cu, Zn, and/or Pb. When your NITON XLp analyzer is operating in 
Industrial Bulk Re/Ta/Hf Testing Mode, the NITON XLp analyzer will 
not measure concentrations of Cu, Zn, or Pb in a sample. Once Industrial 
Bulk Re/Ta/Hf Testing Mode is selected, you may begin testing samples.

Use Industrial Bulk Re/Ta/Hf Testing Mode if: 

• There is more Ta/Hf/Re than Cu/Pb/Zn in the sample

• The percentage of the elements of interest are >1.0%

• The matrix material is not a light matrix

• Elements with atomic number greater than iron (Z = 26) exceed 
several percent

Select the Plastics Analysis icon from the Bulk Mode Menu to place your 
instrument into Plastics Analysis Mode. Use Plastics Analysis Mode to 
find elements of interest in a plastic matrix. Plastics Analysis Mode is not 
available on this analyzer. For further information on Plastics Analysis 
Mode, contact Thermo or your local NITON representative.
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Standard Bulk Mode

Figure 6-7. Standard Bulk Mode Menu

The Standard Bulk Mode is available from the Bulk Mode Menu. The 
Standard Bulk Mode allows you to perform tests on soil and other bulk 
samples without adjusting for a particular matrix. The Standard Bulk 
Mode is ideal for finding contaminants in soil. The Standard Bulk Mode 
uses Compton Normalization to automatically adjust for the effects of the 
matrix. From the Standard Bulk Mode Menu, you can immediately 
initiate a sample test using the proper preconditions for operation, enter 
data about your sample using the Data Entry icon, or return to the Main 
Menu.

Select the Data Entry icon from the Standard Bulk Mode Menu to go to 
the “The Data Entry Screen” on page 6-29, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

This mode of operation is optimum for any sample whose elements of 
interest are present at less than 1%. Standard Bulk Mode utilizes the 
Compton Scatter (Inelastic Collisions) of a particular sample. Compton 
scatter occurs when primary X-rays do not cause fluorescence but instead 
collide with the atoms of the sample. The Compton Scatter that occurs is 
directly proportional to the density (average atomic number (Z)) of the 
sample. A light matrix material, such as an oil or sand, will have a much 
greater scatter than that of a heavy matrix, such as ore. The analyzer 
measures this scatter peak and automatically adjusts the concentration based 
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on the matrix of the material and allows for the analysis of a bulk sample 
without the use of site specific calibration standards. This mode is used 
chiefly for the analysis of contaminants in soils.
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Industrial Bulk
Cu/Zn/Pb Testing

Mode

Figure 6-8. Industrial Bulk Cu/Zn/Pb Testing Mode Menu

The Industrial Bulk Cu/Zn/Pb Testing Mode is available from the Bulk 
Mode Menu. The Industrial Bulk Cu/Zn/Pb Testing Mode allows you 
to perform tests on soil and other bulk samples without adjusting for a 
particular matrix. Industrial Bulk Cu/Zn/Pb Testing Mode is ideal for 
finding concentrations of analytes in rock or soil. This mode of operation is 
optimum for any sample whose elements of interest are present at 1% or 
greater. Industrial Bulk Cu/Zn/Pb Testing Mode utilizes Fundamental 
Parameters to analyze the sample. From the Industrial Bulk Cu/Zn/Pb 
Testing Mode Menu, you can immediately initiate a sample test using the 
proper preconditions for operation, enter data about your sample using the 
Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the Industrial Bulk Cu/Zn/Pb Testing 
Mode Menu to go to the “The Data Entry Screen” on page 6-29, to input 
data about the sample which you are testing. The data you enter will be 
associated with the next sample you test.
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Industrial Bulk
Re/Ta/Hf Testing

Mode

Figure 6-9. Industrial Bulk Re/Ta/Hf Testing Mode Menu

The Industrial Bulk Re/Ta/Hf Testing Mode is available from the Bulk 
Mode Menu. The Industrial Bulk Re/Ta/Hf Testing Mode allows you 
to perform tests on soil and other bulk samples without adjusting for a 
particular matrix. Industrial Bulk Re/Ta/Hf Testing Mode is ideal for 
finding concentrations of analytes in rock or soil. This mode of operation is 
optimum for any sample whose elements of interest are present at 1% or 
greater. Industrial Bulk Re/Ta/Hf Testing Mode utilizes Fundamental 
Parameters to analyze the sample.From the Industrial Bulk Re/Ta/Hf 
Testing Mode Menu, you can immediately initiate a sample test using the 
proper preconditions for operation, enter data about your sample using the 
Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the Industrial Bulk Re/ta/Hf Testing 
Mode Menu to go to the “The Data Entry Screen” on page 6-29, to input 
data about the sample which you are testing. The data you enter will be 
associated with the next sample you test.
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Analyzing Bulk
Samples

CAUTION After being powered on, the NITON 300 Series Analyzer will 
perform an internal re-calibration before an analysis is initiated.  It is 
recommended that you let your instrument warm up for ten minutes after 
start up, before testing is begun. 

There are five different methods of operation for taking a sample 
measurement, and your analyzer will be configured to use one of those 
methods for soil samples, depending on the regulatory requirements of your 
locality. These methods are:

• Trigger-Only method. With the Trigger-Only method, you only 
need to place the measurement window close to the sample to be 
analyzed and pull the trigger for sample analysis to be initiated. 

• Trigger-and-Proximity-Sensor method. With the 
Trigger-and-Proximity-Sensor method, you must place the 
measurement window against the sample to be analyzed to engage 
the proximity sensor on the front of the instrument, then pull the 
trigger for sample analysis to be initiated.

• Momentary-Trigger-Touch-and-Proximity-Sensor method. With 
the Momentary-Trigger-Touch-and-Proximity-Sensor method, you 
must place the measurement window against the surface to be 
analyzed to engage the proximity sensor on the front of the 
instrument, then pull the trigger.

• The trigger may be released and the reading will continue until you 
release the proximity button, or other criteria (such as Max Time) 
are reached. This is the primary mode of operation for the XLp 
300A/700A Series Lead-in-Paint Analyzer in the USA.

• Trigger-and-Interlock method. With the Trigger-and-Interlock 
method, you need to place the measurement window close to the 
sample to be analyzed, press and keep pressing the interlock button 
at the rear of the instrument with your free hand, then pull the 
trigger for sample analysis to be initiated.

• Trigger-Interlock-and-Proximity-Sensor method. With the 
Trigger-Interlock-and-Proximity-Sensor method, you must place the 
measurement window against the sample to be analyzed to engage 
the proximity sensor on the front of the instrument, press and keep 
pressing the interlock button at the rear of the instrument with your 
free hand, then pull the trigger for sample analysis to be initiated.
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• With any of these methods, analysis will stop if any one of the 
preconditions are violated. For example, with the 
Trigger-Interlock-and-Proximity-Sensor method, if the trigger or the 
Proximity Sensor or the Interlock is released, the reading will stop 
immediately, and the shutters will close.

After your NITON XLp analyzer is calibrated, initiate a sample reading 
using the appropriate method. If you attempt to initiate a sample reading 
using a different method, the analyzer will inform you that one or more of 
the preconditions need to be met in order for sample analysis to begin. 

Note The  three LED lights will blink during calibration or whenever there 
is a shutter open. 

WARNING! The preconditions for operation must be continued for the 
duration of the reading. If the preconditions are violated, all the shutters will 
close, and the measurement will end. The three LED lights will stop 
blinking, the shutters will close, and the measurement will end. The flashing 
of the LED lights is not synchronized to minimize power consumption. 

WARNING! The three LED warning lights are designed to blink only 
during a measurement, where one or more of the shutters are open and the 
trigger depressed. If the LED lights blink at any other time, disconnect the 
battery pack immediately, place the instrument in its shielded holster, place 
the holster in the shielded carrying case, and call Thermo Scientific’s Service 
Department in the United States, toll free, at (800) 875-1578, or outside 
the United States, at +1-978-670-7460, or your local Authorized NITON 
Analyzers Service Center. 

Your NITON Analyzer will display the Results Screen throughout the 
duration of each reading, The Results Screen is updated regularly 
throughout the reading. When the reading is complete, a final screen update 
will appear, and your NITON analyzer will display the final results of the 
measurement which has just been completed.
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Figure 6-10. The Results Screen

The Results Screen displays the following information:

• The Reading Number line shows a number automatically assigned 
by your NITON analyzer in order to uniquely identify each reading. 
The reading number automatically increments up by one with each 
successive reading.

• The Nominal Seconds Test Duration line shows the number of 
nominal (source) seconds elapsing since the initiation of the reading. 
Nominal seconds are true, clock seconds slowed down to 
compensate for the electronic dead-time that occurs when the 
NITON XLp is taking a measurement. 

• The Mode line displays the test mode in use during the 
measurement.

• The Element (left) column shows the elements that have been 
detected in the sample. 

• The Concentration Level (central) column shows the 
concentration levels of the corresponding elements in percentages.

• The Confidence (right) column displays the 2 sigma (95%) 
confidence interval for the corresponding elements.

Element 
Column

NAV Menu

Two Sigma 
Confidence 
Column 

Mode

Test Duration Line

Reading Number 

Tools Menu Battery Life 
Indicator

Measured 
Concentra-
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To Prepare or Not to
Prepare - In Situ vs.

Ex Situ

Bulk media are generally tested either on-site (in situ) for screening 
purposes, or removed and prepared (ex situ) to enhance the accuracy of the 
measurement. The degree of preparation may vary depending on the 
accuracy desired, the characteristics of the sample, and the characteristics of 
the site. 

Understanding the advantages of in situ testing and of various degrees of 
preparation is crucial to obtaining useful data. In situ measurements should 
be used to profile an area, locate sources of contamination, determine the 
boundaries of contaminated areas, or gather data that will subsequently be 
used to design a sampling plan. 

In situ measurements are usually only approximations, though they may 
correlate very well with lab analysis if the site tested is highly homogeneous. 
If the site is non-homogeneous, as is often the case, then in situ 
measurement results may differ greatly from laboratory obtained results. 
Both sets of results may be correct. The difference arises from the fact that 
actual samples tested were different. 
Thermo Scientific NITON XLp Analyzer User’s Guide 15



Bulk Sample Test Modes
Analysis of Unprepared Samples – In Situ
Analysis of
Unprepared Samples

– In Situ

Figure 6-11. In-Situ Soil Testing

Screening Techniques Use direct measurement when you need to determine whether an element is 
present (rather than in accurately measuring how much is present). Use 
preliminary direct measurements to survey a site quickly even if you intend 
to take samples 

Testing In Situ

WARNING! When taking samples from a site where toxic chemicals may 
be present, always use gloves and respiration equipment for your own 
protection. 

1. Select a measurement site, and clear away any surface debris and 
vegetation. 
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Note Valid results will depend on a sufficient and appropriate selection of 
sites to sample. Lead-in-soil from paint, for instance, will usually be 
concentrated within a few feet of the painted structure. 

2. Choose an area to test where the measurement window of the 
analyzer will be flush with the test media. Position the nose 
against the surface to be analyzed and initiate a reading by 
squeezing the shutter release, and firmly pressing the instrument 
flat against the surface. 

3. After the test, inspect the nose of the instrument for 
contamination, which may affect future analysis. If the nose 
appears to be soiled, clean it with a soft cloth or tissue. 

WARNING! Always treat radiation with respect. Do not hold your 
instrument near the Kapton window during testing. Never point your 
instrument at yourself or anyone else when the shutter is open. 

Note Never use in situ testing with field portable XRF when comparing 
field results with laboratory results to justify XRF usage. Always collect 
samples and prepare them before testing. Refer to the instructions on sample 
collection and preparation in Ex Situ Testing. 

On-site vs. Lab
Analysis

When comparing field screening to laboratory analysis, it is preferable to 
compare results obtained from the same samples. Start by collecting a 
sample large enough to be divided into two parts, with one portion stored 
for future reference and the other submitted to a laboratory for independent 
analysis. For best results, follow the complete protocol for sample 
preparation, including drying and grinding of the sample. Grinding is 
essential for homogenizing the sample, ensuring that the portion sent to the 
lab is the sample as that analyzed on-site. 

If you must test for in situ performance evaluation, take several XRF 
readings bracketing a spot. Then take a sample for laboratory testing from 
that spot. For further discussion of field screening, please refer to EPA 
Method 6200, “Field Screening Using A Field-Portable XRF,” which can be 
obtained from NITON Corporation’s Customer Service Department. EPA 
accepts field screening results using portable XRF provided that Method 
6200 protocol is followed. 
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In Situ Depth Profiling XRF analysis for soil is a surface technique. To perform a depth profile, 
remove a vertical slice of soil and test several samples taken from different 
depths. This procedure will yield information, rapidly, about the depth of 
contamination. 

Figure 6-12. In-Situ Depth Profiling
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Analysis of Prepared
Samples – Ex Situ

Figure 6-13. Ex-Situ Analysis of Prepared Samples

Analysis of bagged bulk
samples

Sometimes it is convenient to measure samples in plastic bags. Without 
further preparation of the sample, you can screen the site by testing each 
bag. Because you are testing through a bag, test results will tend to be lower 
than test results obtained from direct analysis. This effect will vary 
depending on the element analyzed and the thickness of the plastic through 
which the sample is tested. Bagged samples can be retested and/or be further 
prepared and then retested, allowing samples of particular interest to be 
more accurately analyzed. 

Sample Collection Examine the site for differences in soil characteristics before sampling. Valid 
results depend on a sufficient and appropriate selection of sites to sample. 
Incorrect sample collection may give rise to misleading or meaningless 
results, regardless of the analysis method. Delineate sections with different 
characteristics and treat them as different areas. It may be desirable to 
subdivide larger areas even if they have the same characteristics to ensure a 
thorough examination. 

Note When testing for lead-in-soil in a residential setting, it is standard 
practice to sample the top 4 to 6 inches of soil. 

Place Filter

Tamp Sample

Fill Cup

Secure Film

Place Film

Place Cup
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Lead is usually concentrated near a building with lead paint (within 4–6 
feet), and appropriate sample areas should be defined. Samples from the 
following areas should also be collected and combined separately: 

• near painted structures 

• near roads and driveways 

• near to where various types of waste have been stored, or 

• near pressure-treated wood 

The soil probe or sampling tube is a very convenient sampling tool. It 
quickly takes accurate and consistent samples, and may be inserted to a 
marked depth to removes the same amount of soil at each insertion. In 
addition, there also are core-sampling devices that can remove an intact 
cylinder of sample material. If no sample tool is available, a shovel, spade, 
narrow (1-1/2 inch) garden trowel, or other sampling tool is adequate to 
take a soil slice of the required depth. 

WARNING! When taking samples from a site where toxic chemicals may 
be present, always use gloves and respiration equipment for your own 
protection. 

Individual samples may require reduction in size if they were taken with a 
spade, trowel, or other large sampling tools. Reduce the samples by taking a 
vertical slice (so it is representative of the entire sample) about one inch 
wide. 

Prepare a composite sample from each predetermined area. A composite 
sample of an area consists of many smaller samples from different sections of 
that area. These samples should consist of vertical columns of material 
approximately 1 inch in diameter. The length of each column should be 
about 6 inches. The elements you wish to measure and the local history will 
determine the depth at which you need to sample. For example, lead from 
paint is usually concentrated within the top 1–4 inches. 

Do not combine samples from different areas. A composite sample taken 
from two distinctly different areas is not representative of either area. 

Place the samples in a clean pail. Then mix the sample thoroughly by 
stirring and by rotating the pail at an angle of 45 degrees. Don’t shake the 
sample––you do not want to stratify the sample. 

Cup Ready

Cap Cup

Fill Cup
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Bulk Sample Test Modes
Analysis of Prepared Samples – Ex Situ
A sample should contain at least 50–100 grams of soil. Once the sample has 
been thoroughly mixed, place it in a clean bag that can be closed securely 
(with a twist tie for example). Zip Lock style bags are very convenient, 
though extra care must be taken to ensure the bags do not unseal, which 
could ruin the samples. 

Make certain to label each bag thoroughly. Common information included 
on each bag includes the person and/or the company who collected the 
sample, the location and area where the sample was taken, and the date the 
sample was collected. 

Testing Samples in Bags Flatten the bag of soil to form a continuous uniform layer of at least 1 cm. 
(0.4 inch) thickness. Place the measurement window of the NITON XLp  
Lead Paint Analyzer on the bag. Then follow In Situ testing instructions 
from page 5. 

1. Choose a convenient work surface. This surface should be free of 
material containing elements that may be detected by the 
analyzer. When uncertain of the work surface, test the surface 
with the analyzer. 

2. Flatten the bag of soil to form a continuous uniform layer of at 
least 1 cm. (0.4 inch) thickness. Place the nose of the NITON 
analyzer on the bag. Be careful of bags with manufacturers 
printing or labeling surfaces. This printing often contains 
detectable elements, most notable Ti, and should be avoided 
when possible. 

3. Position the instrument against the surface of the bagged sample, 
and initiate a reading by squeezing the shutter release, and firmly 
pressing the instrument flat against the sample. The trigger and 
the proximity sensor must both be engaged before the shutter will 
open and the measurement initiated. 

WARNING! Do not hold bagged samples while testing. 

Prepared sample analysis is the most accurate method for determining the 
concentration of elements in a bulk medium using the instrument. Sample 
preparation will minimize the effects of moisture, large particle size, 
variations in particle size and sample non-homogeneity. 
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Bulk Sample Test Modes
Analysis of Prepared Samples – Ex Situ
Note: More sample preparation (drying, milling and sifting) will yield 
greater accuracy. The drier, finer, and more homogeneous the particles, the 
better the measurements. 

Preparing Bulk Soil
Samples

Thermo NITON recommends a specific sample protocol. Following this 
protocol for preparing and testing samples is vital for achieving a level of 
accuracy comparable with laboratory results. 

The equipment you need to prepare samples is included in your kit. Among 
these are a mortar and pestle, several different sized metal sieves, cups to 
hold the samples, and the soil test platform. 

CAUTION All test equipment must be kept clean to prevent 
contamination of samples. 
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Bulk Sample Test Modes
Cleaning Your Equipment:
Cleaning Your
Equipment:

The mortar, pestle, and grinding mill may be cleaned with dry paper towels. 
You can also clean the mortar, pestle, and the mill’s container with water, 
but be sure each is absolutely dry before using them on another sample. The 
mortar and pestle may be cleaned by grinding clean, dry sand in the mortar. 
Use the short bristle brushes (included in your Soil Testing Kit) to clean the 
sieves. If you have an electric soil grinder in your kit, when the soil grinder 
blades wear out, unbolt the worn blades and replace them. Call the Thermo 
Sales Department at 1-800-875-1578 for replacement blades. 

Note Using the soil grinder may artificially increase the amount of Fe in soil 
samples. 

Sample Preparation Prior to analysis, the material should be dry and well homogenized. Ideally, 
the entire sample should be dried to constant weight, sifted to remove gravel 
and debris, and ground or milled to a fine powder. 

Dry the sample if it is moist and cohesive. The sample can be dried in any of 
several ways. Choose one of the following: 

• Oven dry the sample for approximately 2 hours at 150° C, until the 
sample reaches a constant weight. Note: Oven drying is 
inappropriate when volatile compounds may be present in the 
sample. For example, lead present as tetraethyl lead would be driven 
off by the heat of drying. Some forms of mercury and arsenic are 
volatile. Air drying will preserve more of these volatile substances. 

• Air dry the sample overnight at room temperature in a shallow pan. 

• Stir gently and warm the sample in a pan over a hot plate or burner. 

Coning and Quartering You may need to divide your sample at various times during preparation. 
Coning and quartering is a method for dividing the sample into 
homogenous quarters. 

• Pour the dry material slowly and carefully onto a flat sheet or pan, 
forming a symmetrical cone. Divide the cone into equal piles using a 
flat thin-bladed tool, such as a knife or ruler. Divide these in half 
again. 

• Now you have four samples, each one-quarter the size of the original 
and each more homogenous than the original. 

• Grind the sample to break up dirt clods and/or paint chips. 
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Bulk Sample Test Modes
Cleaning Your Equipment:
WARNING! Grinding and sifting dried samples produces dust. Even clean 
soil contains silica, which may be hazardous when airborne. Prepare all 
samples in a ventilated area; wear a mask, gloves, and an apron; and spread a 
drop cloth. 

Sift using the #10 (2mm) mesh and separate out the larger pieces (stones, 
organic matter, metallic objects, etc. Examine the larger particles by eye 
(look for paint chips), but do not include in the sample. Grind the sample 
again so its particles will be finer and more homogenous. Use mortar and 
pestle, or an electrically powered grinding mill. Sift at least 10 grams of the 
sample through #60 (250 μm) and #120 (125 μm) mesh. Re-grind the 
un-passed material until the entire fraction is able to pass. Mix the resulting 
sample. 

Placing the Sample in an
XRF Sample Cup

The container used to hold the sample will affect the accuracy of the 
measurement. Use a container with as thin-walled a window as is convenient 
and use the same kind of container and window for each sample. 
Consistency and careful attention to detail are keys to accurate 
measurement. 

Note The sample container should be a sample cup of a type that can be 
filled from the rear; that is, the side opposite the window (e.g. Thermo 
NITON Part Number 187-466). Thermo recommends using a 1/4 mil 
Mylar film (e.g. Thermo NITON Part Number 187-492). A supply of cups 
and films are included. 

Place a circle of Mylar film on top of an XRF sample cup. This film goes on 
the end of the cup with the indented ring. Thermo recommends preparing 
the cup ahead of time, if possible. 

Secure the film with the collar. The flange inside the collar faces down and 
snaps into the indented ring of the cup. Inspect the installed film window 
for continuity and smooth, taut appearance. 

Set the cup on a flat surface film-window-side down. Fill it with at least five 
grams of the prepared sample, making sure that no voids or uneven layers. 

PLACE FILM

SECURE FILM

FILL CUP
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Bulk Sample Test Modes
Cleaning Your Equipment:
Lightly tamp the sample into the cup. The end of the pestle makes a 
convenient tamper. 

Place a filter-paper disk on the sample after tamping it. 

Fill the rest of the cup with polyester fiber stuffing to prevent sample 
movement. Use aquarium filter or pillow filling as stuffing. A small supply 
of stuffing comes with your bulk sample kit. 

Cap the cup.

Place a label on the cup. Using a pen with indelible ink, write identifying 
information on the cup. Keep a record of the sample designation, the site 
and location, the date of the sample, and any other relevant comments. 

Cup is ready for testing.

Preparing Liquids,
Sludge or Dust

Liquids Fill an XRF sample cup with the liquid to be tested (do not pad the sample 
with cotton). The cup must be full so it is best if some liquid is allowed to 
overflow when the cap is put on. 

Sludge Sludge can be placed directly into an XRF cup for screening. This is 
considered in-situ testing because no attempt has been made to prepare the 
sample. For more accuracy, the sludge can be dried, sieved, and ground. 

TAMP SAMPLE

PLACE FILTER

STUFF CUP

CAP CUP

PLACE LABEL

CUP READY
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Bulk Sample Test Modes
Cleaning Your Equipment:
Dust Vacuum dust with a household vacuum cleaner and use large dust samples 
taken from the vacuum cleaner bag. Remove fibers, hairs, and debris. At 
least three grams of dust are needed to assure accurate analysis. Samples as 
small as one or two grams may be measured with less accuracy. Even smaller 
samples (0.3 to 1.0 grams) can be analyzed by applying a weight correction 
factor and by using a funnel to place the sample in the center of the sample 
cup. 

Prepare in an XRF sample cup and test the same way you would with a soil 
sample. For risk analysis, it is advisable to use a 60-mesh sieve to isolate and 
test only fine particles. 
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Bulk Sample Test Modes
Standard Soil Mode
Standard Soil Mode Thermo provides a set of three soil standards containing either NIST high, 
NIST medium, and NIST low, or containing NIST high, TILL-4, and 
NCS DC 73308. Use these standards to check the calibration of the 
instrument when testing in Standard Soil Mode. For the compositions of 
these standards, see Chapter 2 - page 66.

Note Although the standards do not contain every element that the Lead 
Paint Analyzer is capable of testing, and although the standards do contain 
elements that the analyzer is not capable of testing, it can be assumed that 
the XLp Environmental Analyzer will measure all elements correctly if it 
correctly measures those elements contained in the standards supplied. 

Test the standards regularly. Thermo recommends testing immediately after 
the instrument finishes self-calibration. Test the standard samples 
appropriate to the type of tests you are conducting, and once every 1–2 
hours thereafter. 

Note For defensible Quality Control, keep a record of the time and 
precision of every calibration, using the bar code system when possible. 

WARNING! Tampering with the 5,500 ppm (lead high) lead-in-soil 
standard may cause exposure to lead dust. Keep all standards out of the 
reach of children. 

CAUTION Never tamper with Test Standards. They should not be used 
unless they are completely intact. 

During each test, the instrument looks at the full range of x-ray spectrum 
and continuously corrects for cross-element interference. 

Testing Prepared
Samples

Set the test platform on a flat, solid surface. Slide out the drawer and place 
the sample cup in the holder and slide the drawer shut. Insert the 
instrument into the nose cone adaptor so that the LCD screen is facing the 
side that the test platform drawer is on, and follow in-situ bulk sample 
instructions 
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Bulk Sample Test Modes
FP Soil Testing Modes
FP Soil Testing
Modes

These modes of the operating software are intended primarily for the 
detection of metal concentrations greater than 1% in light or heavy 
matrices. The full fundamentals parameter (FP) algorithm accurately 
measures elemental concentrations from minor levels to 100%, and 
automatically corrects for inter-element effects. However, elements lighter 
than calcium cannot be detected by XRF and light element combinations, 
such as oxides, carbonates, and silicates are common matrix components. To 
fine-tune results, you may enter calibration factors for individual elements 
to adjust for effects of light element interference. These calibration factors 
are linear corrections, which adjust the FP calculation. Calibrations only 
need to be entered once per matrix. However, as matrices can vary 
considerably from one sampling area to another, it is recommended that 
new calibrations be done for each change in matrix. 

Using both the 109Cd and 241Am sources, concentrations for the following 
analytes can be determined: 

Ti, V, Cr, Mn, Fe, Co, Ni, Cu, Zn, W, Pb, Bi, Zr, Ta, Nb, Mo, Sn, and Ag. 

All concentrations are displayed in units of wt.%. 

Note For defensible Quality Control, keep a record of the time and 
precision of every calibration, using the bar code system wherever possible. 

WARNING! Tampering with the 5,500 ppm (lead high) lead-in-soil 
standard may cause exposure to lead dust. Keep all standards out of the 
reach of children. 

CAUTION Never tamper with Test Standards. They should not be used 
unless they are completely intact. 

During each test, the instrument looks at the full range of x-ray spectrum 
and continuously corrects for cross-element interference. 

Testing Prepared
Samples

Set the NITON test platform on a flat, solid surface. Slide out the drawer 
and place the sample cup mylar side facing up in the holder and slide the 
drawer shut. Insert the instrument into the nose cone adaptor so that the 
LCD screen is facing in the same side as the test platform drawer and follow 
ex-situ bulk sample instructions
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Bulk Sample Test Modes
The Data Entry Screen
The Data Entry
Screen

The Data Entry Screen is accessed whenever you select the Data Entry 
icon from any screen. This screen allows you to input data in several 
different fields, or categories, concerning your sample, in several different 
ways:

• By selecting the Virtual Keyboard button and typing the parameter in 
using the Virtual Keyboard. 

• By scanning in the parameter name using the integrated bar code 
scanner.

• By creating a new, or editing your analyzer's existing, '.ndf' file through 
the NDT program. You can then select from the various custom options 
you have created using the Drop-down List button.

These fields are saved along with the subsequent reading, and allow you to 
associate important information about the sample directly with the reading, 
so that you have a full description of the sample tied into the reading itself.

Once you have input data into a field, that information carries over into the 
next reading, so that you only have to input the information that has 
changed since the last reading. For example, if you are analyzing several 
samples of a particular lot, you only need to input the lot information once 
during that series of readings, changing only the sample name.
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Bulk Sample Test Modes
The Data Entry Screen
Standard Soil Mode Data
Entry Screens

Figure 6-14. Data Entry Screens Standard Soil Mode - First Page

This is the first section of the Standard Soil Data Entry Screen. There 
are five parameters in this section.

• Selecting Sample allows you to input the sample name parameter

• Selecting Location allows you to input the particular location 
information, if known

• Selecting Inspector allows you to specify the inspector.

• Selecting COR 1 allows you to specify the first coordinate.

• Selecting COR 2 allows you to specify the second coordinate.
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Bulk Sample Test Modes
The Data Entry Screen
Figure 6-15. Data Entry Screens Standard Soil More - Second Screen

his is the second section of the Standard Soil Data Entry Screen. There are 
two parameters in this section.

Selecting Misc allows you to input miscellaneous parameters

Selecting Note allows you to input notes on the sample
Thermo Scientific NITON XLp Analyzer User’s Guide 31



Bulk Sample Test Modes
The Data Entry Screen
Data Entry Screens for
all other Bulk Modes

Figure 6-16. Data Entry Screen - Other Bulk Mode

This is the only section of the Data Entry Screen. There are five param-
eters in this section.

• Selecting Sample allows you to input the sample name parameter

• Selecting Location allows you to input the particular location 
information, if known

• Selecting Inspector allows you to specify the inspector.

• Selecting Misc allows you to input miscellaneous parameters

• Selecting Note allows you to input notes on the sample

Figure 6-16
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Bulk Sample Test Modes
Navigating the Data Entry Screen
Navigating the Data
Entry Screen

Figure 6-17. The Control Panel

The following description of screen navigation using the control panel 
assumes that the analyzer is held so that the display is held upright as in 
Figure 6-17.

• To move from column to column, use the Right and Left portion of the 
4-way touch pad.

• To move from row to row, use the Up and Down portions of the 4-way 
touch pad.

• To select the highlighted option, press the Enter button on the control 
panel. 

The Data Entry Screen is divided into sections of 5 setting parameters. By 
using the Down portion of the 4-way touch pad when you are on the last 
row of a section, the display will change to the next section. By using the Up 
portion of the 4-way touch pad when you are on the first row of a section, 
the display will change to the previous section. 

By selecting the On/Off button, you can exit the Data Entry Screen.

Touch Screen 
Display

On/Off 
Button

Down

Right

4-way
 touch-pad

Up

Enter
Button

Left
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Navigating the Data Entry Screen
The Virtual Keyboard

Figure 6-18. The Virtual Keyboard

The Virtual Keyboard is a full alphanumeric keyboard which appears on the 
LCD Touch Screen Display. You can use the Virtual Keyboard either with 
the four-way touch pad and control panel buttons, or using the touch screen 
display directly. 

At the top of the screen is the data field you are entering data for, in this 
case, “Sample”, Directly underneath is the data you are entering, in this case 
“17-4 PH SS”, On this line also is the underscore cursor. This graphically 
shows where the next character will be placed. Up to 25 characters can be 
stored in the data fields.

Lower Case Virtual Keyboard

Upper Case Virtual Keyboard
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Bulk Sample Test Modes
Navigating the Data Entry Screen
Next is the Virtual Keyboard itself, with numbers 0-9, letters A-Z, and 
special characters *,<,>, and -.

Last is the control button line. This contains the screen buttons for Return 
and Clear.

When using the four-way touch pad and control buttons, pressing the 
On/Off button allows you access to the Return and Clear screen buttons. 
The Return screen button will enter the data and return you to the Data 
Entry Screen, while the Clear screen button will clear the data you have 

All screen areas can be directly accessed using the LCD Touch Screen.
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NITON Test
Platforms

Figure 6-19. NITON Bulk Mode Test Stand

The NITON Bulk Test Stand is designed to facilitate bulk and thin sample 
testing using NITON Analyzers.The NITON Portable Test Stand is 
designed for bulk and moderate sized samples, and is portable.

Nose Cone
Adapter

Release Button
Test Surface Cutout

Support Arm

Sample Storage Tray Sample Test 
Analysis
Window

Test

Lever
Platform

Drawer

Support Arm Kickstand

Post
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NITON Test Platforms
Figure 6-20. NITON Portable Test Stand

NITON RCRA
Verification Response

Sample

This sample contains 7 of the 8 RCRA metals as follows:

As, Ba, Cd, Cr, Pb, Se, and Ag

NITON may recommend the analysis of this sample if you question the 
data that the instrument is displaying for the above elements.

Sample Test Area

NITON Analyzer
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Chapter 7 Precious Metals Mode

Using Precious
Metals Mode

Precious Metals Mode is not enabled on your Niton XLp analyzer. For more 
information on this feature please contact Thermo Scientific’s Customer 
Service Department in the United States, Toll free, at (800) 875-1578, or 
outside the United States at + 1-978-670-7460 or your authorized Niton 
Analyzer Service Center.
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Precious Metals Mode
Using Precious Metals Mode
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Chapter 8 Bluetooth

Setting up Bluetooth Bluetooth Wireless Networking enables you to connect to your computer 
and other Bluetooth-enabled devices such as printers and GPD S devices 
without the need of cabling, ports, or hubs.

Figure 8-1. The Wireless Setup Menu

To access the Bluetooth Wireless Networking, select the Wireless Setup icon 
from the Instrument Setup Menu.

Select the List Available Devices icon to show a list of Bluetooth devices 
previously discovered. The Bluetooth devices listed are only those which 
were present at the last time you ran a discovery scan for Bluetooth devices, 
as the list is not automatically updated. Selecting the List Available 
Devices icon brings up the Available Devices screen. From the list, you 
can connect your analyzer to those devices.

Select the Scan For Devices icon bring up the Bluetooth Search Screen, 
enabling you to initiate a discovery scan of Bluetooth devices in the 
operational area. This scan will find all appropriate Bluetooth devices in the 
operational area, enabling you to connect to those devices. 
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Bluetooth
Setting up Bluetooth
Select the Bluetooth Status icon to view the current status of your 
Bluetooth connections on the Bluetooth Status screen. The Bluetooth 
Status screen will display your analyzer’s serial number, connection status, 
the transfer rate, and your analyzer’s address 

Select the Reset Bluetooth Device icon to initiate an immediate reset of 
the Bluetooth Wireless Networking. Selecting the Reset Bluetooth Device 
icon will clear out old settings and data, as well as enabling you to switch 
between Bluetooth and standard serial cable. While resetting, your analyzer 
will show the following screen:

Figure 8-2. Bluetooth Reset Alert
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Bluetooth
Available Devices Screen
Available Devices
Screen

 

Figure 8-3. Available Devices Screen

Under “Devices,” in the Device List Box, the Available Devices Screen lists 
all known applicable Bluetooth devices in the area found during the last 
refresh or scan. 

Figure 8-4. Example Device List

Device List Box

Connect Button

Refresh Button

Close Button
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Bluetooth
Available Devices Screen
• Selecting the Refresh Button initiates a scan of the area for new 
Bluetooth devices. Devices no longer present are removed.

Figure 8-5. Available Device Refresh

• Selecting a listed Bluetooth Device enables the Connect Button.

• Selecting the Connect Button will connect your analyzer to the selected 
device. See the Connected Screen.
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Bluetooth
Bluetooth Search Screen
Bluetooth Search
Screen

Figure 8-6. Bluetooth Search Screen

The Bluetooth Search Screen does not retain information about 
previously detected Bluetooth Devices. Each time the Bluetooth Search 
Screen is opened, the Device List Box is empty. 

• Selecting the Search Button initiates a scan for Bluetooth Devices in the 
area.

Device List Box

Connect Button

Search Button

Close Button
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Bluetooth
Bluetooth Search Screen
Figure 8-7. Example Search List

Depending on where and when the Search Scan is conducted, certain 
devices may or may not be detected. You can select a device and connect to 
that device in exactly the same manner as in the Available Devices Screen, 
once the search is finished.

Figure 8-8. Search List with New Device Found
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Bluetooth
The Connected Screen
The Connected
Screen

Figure 8-9. The Connected Screen

When you have connected your analyzer to a Bluetooth Device, you get the 
Connection Screen. The Connection Screen serves as a reminder of what 
needs to be done to use the connection. With simple devices like GPS 
devices, a notification that you are connected is given, and everything just 
works, but working with a PC is a bit more complex.

In order to use a Bluetooth Serial Connection with a PC, you need to know 
which COM port Bluetooth is connected through. To determine this, right 
click on the Bluetooth logo in your system tray on your PC. From the 
popup menu which appears, select Advanced Config., then select Local 
Services. 

Figure 8-10. Advanced Configuration selection on PC
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Bluetooth
The Connected Screen
Figure 8-11. Bluetooth Service Listing on PC

In the Bluetooth Serial Port row, the COM port used by Bluetooth is 
identified. Use this port for any interactions between your analyzer and your 
computer, such as NDT or NDTr. 

Make sure that the Secure Connection setting for the Bluetooth Serial Port 
is set to “Not Required.” 

Figure 8-12. Selecting Bluetooth Serial Port on PC

To edit the setting, double click the row.’
8 NITON XLp Analyzer User’s Guide Thermo Scientific



Bluetooth
The Connected Screen
Figure 8-13. Changing the Bluetooth Secure Connection Checkbox 
on PC

Unselect the Secure Connections checkbox if it is already selected, then 
select the “OK” button.
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Bluetooth
Bluetooth Status Screen
Bluetooth Status
Screen

The Bluetooth Status Screen enables you to see at a glance if and how your 
analyzer is connected to your computer.

 

Figure 8-14. Example Bluetooth Status Screen

The Bluetooth Status Screen shows your analyzer’s identification label, its 
connection state, the speed of the communication port setting, your 
analyzer’s network address, and the COD. 

In Figure 8-14, the analyzer “XLt 8789” is not connected to any computer, 
was last in Slave state - i.e. the last connection was initiated by the computer 
and not by the analyzer, has a com port set to communicate at 115200 
baud, has the unique network (MAC) address of 00A0960CE598, and has a 
COD (Class Of Device) of 00000000.

The Close screen button will return you to the Wireless Setup Menu.
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Bluetooth
Bluetooth Status Screen
 

Figure 8-15. Second Example Bluetooth Status Screen

In another example, in Figure 8-15, the analyzer “XLt 8789” is connected to 
the computer JAMEEL_P, is currently in Master state - i.e. connection was 
initiated by the analyzer and not by the computer, has a com port set to 
communicate at 115200 baud, has the unique network (MAC) address of 
00A0960CE598, and has a COD (Class Of Device) of 00000000.
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Bluetooth
GPS Data Tracking
GPS Data Tracking Bluetooth equipped Niton XRF Analyzers are now capable of 
communicating with GPS modules and saving GPS coordinates with every 
reading. Follow the Bluetooth connection instructions found in the Users 
Manual to scan for and connect to a Bluetooth enabled GPS device.

Once connected, the GPS unit sends out a number of signals that can be 
read. The analyzer will display the relevant information from the GPS after 
connection, as shown in Figure 8-16

As shown in Figure 8-17, these coordinates can be viewed in the Data screen 
in entry positions eight, nine, and ten. (Scroll down to reach these fields.) 
When the results are downloaded using the NDT software the GPS 
coordinates are also stored and downloaded in data entry fields eight, nine 
and ten.

Figure 8-16. Example of GPS Data

Example of GPS Data • 2:52:13 GMT - Greenwich Mean Time obtained from the GPS 
satellites.

• Lat: 3355.2607 -Latitude coordinate of current location. This 
should be read as:

• All digits to the right of the decimal point are seconds.

• First two digits to the left of the decimal point are minutes.
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Bluetooth
GPS Data Tracking
• The next two or three digits to the left of the decimal point are 
degrees.

• Thus 3355.2607 is read 33 degrees 55 minutes 26.07 seconds.

• N/S: S - Compass direction of Latitude.

• Long: 15111.594 - Longitude coordinate of current location.

• All digits to the right of the decimal point are seconds.

• First two digits to the left of the decimal point are minutes.

• The next two or three digits to the left of the decimal point are 
degrees.

• Thus 15111.594 is read 151 degrees 11 minutes 59.4 seconds.

• W/E: E - Compass direction of Longitude.

• Altitude: 17 - Height above sea level in meters.

• Quality: 1 - Quality of signal strength. 

• Num Sat: 8 - Number of satellites signals being received by GPS. 
This number varies depending on your position, the current 
position of the satellites, and the signal strength.

Figure 8-17. GPS Data Integrated Into Reading Data
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GPS Data Tracking
GPS Options The communication system standard required for compatibility is 
NMEA0182 ver. 3.0, using GPGGA, GPGSA, GPRMC, and GPGSV 
formats. This type of GPS is most commonly used for motor and marine 
directional mapping systems.

Tested Units include: Copilot BTGPS3

http://www.alk.com/copilot/pocketpc.asp

RoyalTek Star111

http://www.royaltek.com/index.php/content/view/98/80/

IOGEAR Bluetooth GPS

http://www.iogear.com/main.php?loc=product&Item=GBGPS201W6

Note These GPS systems have an accuracy of about 10 meters.
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Chapter 9 Routine Maintenance 
Guidelines

Battery Pack and
Battery Charger

Each Niton 300Analyzer is shipped with two lithium ion battery packs. 
When fully charged, the battery pack provides approximately 6-8-12 hours 
of use, depending on duty cycle. 

There are two types of battery chargers distributed with Niton XRF 
Analyzers. The Trickle Charger shows a solid red light while charging, then a 
green light once charging is complete.

The other battery charger has 2 lights in the top of the battery charger. 
When connected to a wall outlet, the lights will display the following 
information:

Replacement battery packs (Niton part number 600-540) may be ordered 
from Thermo Scientific in the United States, toll free, at (800) 875-1578, or 
outside the United States, at +1-978-670-7460, or from your local 
Authorized Niton Analyzers Service Center.

Note Before beginning a test, be certain that the battery has sufficient 
charge. 

CAUTION Do not leave the battery pack connected to the charger for 
excessive periods of time. Overnight recharging is recommended. 

CAUTION Store the analyzer and the spare battery packs in a cool place, 
away from direct sunlight. 

Table 9-1. Battery Charger Status Display

Left Hand Light Right Hand Light Battery Status

ON OFF CHARGING

ON ON 80% CHARGED

OFF ON COMPLETE

BLINK BLINK ERROR

OFF OFF NO BATTERY
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Routine Maintenance Guidelines
Battery Pack and Battery Charger
Replacing The Battery
Pack

1. Rest your Niton analyzer on a clean surface. Avoid damp or dusty 
environments.

2. Point the front of the analyzer away from you, and press in the 
battery housing latch.

3. Slide out the battery pack out toward you. 

4. Fully insert the new battery pack, making sure that it seats 
properly.

5. Press in until the latch resets.

Figure 9-1. Location of the Battery Housing Latch

Recharging The Battery
Pack

Fully recharging a Niton XLp battery pack takes approximately 2 hours. 

1. Remove the battery pack from the analyzer.

2. Lifting the gasket flap, plug one end of the Battery Charger (AC 
adapter or 12V adapter) into the battery charger port.

3. Plug the other end of the AC adapter into a wall socket.
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Routine Maintenance Guidelines
Battery Pack and Battery Charger
Figure 9-2. Location of the Battery Charger Port

CAUTION Do not force the charger into the RS-232 port!  

CAUTION Do not store battery packs or charger in direct sunlight. 

The AC adapter/Battery Charger comes with a convenient indicator light to 
inform you when the battery is fully charged.

CAUTION Do not let the battery pack recharge for excessive periods of 
time.
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Routine Maintenance Guidelines
Maintenance, Cleaning and Repairs
Maintenance,
Cleaning and

Repairs

To ensure the reliability, durability, and performance of your Niton 
Analyzer, keep it clean—especially the transparent Kapton window covering 
the analysis window. Clean the Kapton window gently with a cotton swab. 
Clean the body of the analyzer with a soft cloth. Never use detergents, or 
solvents on your analyzer, or immerse your analyzer in water. If the Kapton 
window becomes frayed, ripped, or contaminated with metal particulates, 
replace it with a new window. Kapton windows (Niton P/N 187-095) may 
be ordered from Thermo Scientific’s Service Department in the United 
States, toll free, at (800) 875-1578, or outside the United States, at 
+1-978-670-7460 or from your local Authorized Niton Analyzers Service 
Center.

From time to time, your touch screen will need cleaning. Thermo Scientific 
recommends that you use a lens cleaning solution with a soft cloth. Do not 
use water to clean your Niton Analyzer.   

Note All Service, except exterior cleaning and Kapton window replacement, 
must be performed by Thermo Scientific or an Authorized Niton Analyzers 
Service Center. Do not attempt to make repairs yourself. Opening the case 
of your analyzer will void the analyzer Warranty in its entirety. 

CAUTION Always obtain a Return Authorization (RA) number from 
Thermo Scientific’s Service Department in the United States, toll free, at 
(800) 875-1578, or outside the United States, at +1-978-670-7460 before 
returning your analyzer to the Niton Service Department or local 
Authorized Niton Analyzers Service Center. 
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Routine Maintenance Guidelines
Replacing the Kapton Window
Replacing the
Kapton Window

1. Remove the three Phillips head screws.

Figure 9-3. View of Face Plate and Kapton Window

2. Remove the face plate and place it face down. 

Figure 9-4. Face Plate Removed showing Kapton Window on 
Reverse

3. Remove the old Kapton window. 

4. Clean the back surface of the face plate and install the new 
Window.
Thermo Scientific NITON XLp Analyzer User’s Guide 5



Routine Maintenance Guidelines
Replacing the Kapton Window
5. Turn the face plate over and replace it on the analyzer's front 
end, fitting the plate carefully over the Proximity Button.

Figure 9-5. Fitting Face Plate over Proximity Button

6. Reinstall the three screws, being careful not to over-tighten them.

Figure 9-6. Replacing the Screws.
6 NITON XLp Analyzer User’s Guide Thermo Scientific



Routine Maintenance Guidelines
Storing and Transporting Your Niton XLp  Analyzer
Storing and
Transporting Your

Niton XLp  Analyzer

All Niton Analyzers are transported in waterproof, drop-resistant, fully 
padded carrying cases with padlocks. In most countries, Niton XRF 
analyzers may be transported by car or plane or shipped as an ordinary 
package. For most courier services, no special labels are required on the 
outside of the Niton analyzer case or on additional packaging.

Figure 9-7. The Niton Carrying Case

All padlocks are shipped with a default combination of “0-0-0”. If you 
change this combination, please inform Thermo Scientific of the new 
combination if you return the unit for service.

To change the combination: 

1. Dial the default combination to open the lock, and pull out the 
shackle. 

2. Rotate the shackle 180 degrees and push it down as far as it can 
go. 

3. While holding the shackle down, rotate it 90 degrees back in 
either direction and release shackle. 

Padlock Locations
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Routine Maintenance Guidelines
Storing and Transporting Your Niton XLp  Analyzer
4. Change the dial settings to the desired combination, record the 
combination, and without disturbing the dials, rotate the shackle 
back 90 degrees to the position it had in step 2.

5. Pull shackle out and rotate it 180 degrees and secure it. Your lock 
now has its own secret combination. 

CAUTION Always transport the unit in its padded carrying case, and store 
the Niton Analyzer in its case whenever it is not being used. 

CAUTION In most cases, no notification is required if transporting within 
state boundaries. This may not be the case when entering federal properties. 


CAUTION Within the United States, always keep a copy of the US DOT 
compliance statement in your Niton analyzer case at all times. A copy is 
included with your analyzer. 

CAUTION Always follow all pertinent local and national regulations and 
guidelines, wherever your XLp 300 series analyzer is transported or used. 

CAUTION Always obtain a Return Authorization (RA) number from 
Thermo Scientific’s Service Department in the United States, toll free, at 
(800) 875-1578, or outside the United States, at +1-978-670-7460 before 
returning your analyzer to the Service Department or to your local 
Authorized Niton Analyzers Service Center. 

CAUTION If you return your Niton analyzer without the carrying case, 
you will void your Niton 300 Series Analyzer's warranty in its entirety. You 
will be billed for a replacement case plus any repairs resulting from improper 
shipping. 

CAUTION Always remove the battery pack when transporting or storing 
your analyzer. 

Note THE Niton SPECTRUM ANALYZER CONFORMS TO THE 
CONDITIONS AND LIMITATIONS SPECIFIED IN 49 CFR 173.424 
FOR EXCEPTED RADIOACTIVE MATERIAL. 
EXCEPTED-PACKAGE INSTRUMENTS AND ARTICLES, N.O.S. 
UN-2911. 
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Appendices 

 Appendix A: X-ray Emission Energies Arranged Alphabetically by Element, by 
Atomic Number

Table A-1. X-ray Emission Energies Arranged Alphabetically by Element, by Atomic Number

Element Symbol Atomic 
Number

Atomic 
Weight

Ka Kb La Lb Lg

potassium K 19 39.10 3.3 3.7

calcium Ca 20 40.80 3.7 4.0

scandium Sc 21 44.96 4.1 4.5

titanium Ti 22 47.90 4.5 4.9

vanadium V 23 50.94 4.9 5.4

chromium Cr 24 52.00 5.4 5.9

manganese Mn 25 54.94 5.9 6.5

iron Fe 26 55.85 6.4 7.1

cobalt Co 27 58.93 6.9 7.6

nickel Ni 28 58.70 7.5 8.3

copper Cu 29 63.55 8.0 8.9

zinc Zn 30 65.38 8.6 9.6

gallium Ga 31 69.72 9.2 10.3

germanium Ge 32 72.59 9.9 11.0

arsenic As 33 74.92 10.5 11.7

selenium Se 34 78.96 11.2 12.5

bromine Br 35 79.90 11.9 13.3

krypton Kr 36 83.80 12.6 14.1

rubidium Rb 37 85.47 13.4 15.0

strontium Sr 38 87.62 14.1 15.8

yttrium Y 39 88.91 14.9 16.8

zirconium Zr 40 91.22 15.7 17.7

niobium Nb 41 92.91 16.6 18.6

molybdenum Mo 42 95.94 17.4 19.6

technetium Tc 43 98.00 18.3 20.6 2.4 2.5 2.8
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Appendix A:
ruthenium Ru 44 101.07 19.2 21.7 2.6 2.6 3.0

rhodium Rh 45 102.91 20.2 22.8 2.7 2.8 3.1

palladium Pd 46 106.42 21.1 23.9 2.8 3.0 3.3

silver Ag 47 107.87 22.1 25.0 3.0 3.2 3.5

cadmium Cd 48 112.41 23.1 26.1 3.1 3.3 3.7

indium In 49 114.82 24.1 27.4 3.3 3.5 3.9

Tin Sn 50 118.71 25.2 28.6 3.4 3.7 4.1

antimony Sb 51 121.76 26.3 29.9 3.6 3.8 4.3

tellurium Te 52 127.60 27.4 31.1 3.8 4.0 4.6

iodine I 53 126.90 28.5 32.4 3.9 4.2 4.8

xenon Se 54 131.30 29.7 33.8 4.1 4.4 5.0

cesium Cs 55 132.91 30.9 35.1 4.3 4.6 5.3

barium Ba 56 137.33 32.1 36.6 4.5 4.8 5.5

lanthanum La 57 138.91 33.3 38.0 4.7 5.0 5.8

cerium Ce 58 140.12 34.6 39.5 4.8 5.3 6.0

praseodymium Pr 59 140.91 35.9 41.0 5.0 5.5 6.3

neodymium Nd 60 144.24 37.2 42.5 5.2 5.7 6.6

promethium Pm 61 145.00 38.5 44.0 5.4 6.0 6.9

samarium Sm 62 150.35 39.9 45.6 5.6 6.2 7.2

europium Eu 63 151.96 41.3 47.3 5.8 6.5 7.5

gadolinium Gd 64 157.25 42.8 48.9 6.1 6.7 7.8

terbium Tb 65 158.92 44.2 50.7 6.3 7.0 8.1

dysproium Dy 66 162.50 45.7 52.4 6.5 7.3 8.4

holmium Ho 67 164.93 47.3 54.2 6.7 7.5 8.7

erbium Er 68 167.26 48.8 56.0 6.9 7.8 9.1

thulium Tm 69 168.93 50.4 57.8 7.2 8.1 9.4

ytterbium Yb 70 173.04 52.0 59.7 7.4 8.4 9.8

lutetium Lu 71 174.97 53.7 61.6 7.7 8.7 10.1

hafnium Hf 72 178.49 55.4 63.6 7.9 9.0 10.5

tantalum Ta 73 180.95 57.1 65.6 8.1 9.3 10.9

tungsten W 74 183.85 58.9 67.6 8.4 9.7 11.3

rhenium Re 75 186.20 60.7 69.7 8.7 10.0 11.7

osmium Os 76 190.20 62.5 71.8 8.9 10.4 12.1

Table A-1. X-ray Emission Energies Arranged Alphabetically by Element, by Atomic Number

Element Symbol Atomic 
Number

Atomic 
Weight

Ka Kb La Lb Lg
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Appendix A:
iridium Ir 77 192.20 64.3 73.9 9.2 10.7 12.5

platinum Pt 78 195.09 66.2 76.1 9.4 11.0 12.9

gold Au 79 196.97 68.2 78.4 9.7 11.4 13.4

mercury Hg 80 200.59 70.2 80.7 10.0 11.8 13.8

thallium Tl 81 204.37 72.2 83.0 10.3 12.2 14.3

lead Pb 82 207.19 74.2 85.4 10.5 12.6 14.8

bismuth Bi 83 208.98 10.8 13.0 15.2

polonium Po 84  (209.0) 11.1 13.4 15.7

astatine At 85  (210.0) 11.4 13.9 16.2

radon Ra 86  (222.0) 11.7 14.3 16.8

francium Fr 87  (223.0) 12.0 14.8 17.3

radium Ra 88  (226.0) 12.3 15.2 17.8

actinium Ac 89  (226.0) 12.7 15.7 18.4

thorium Th 90 232.04 13.0 16.2 19.0

protactinium Pa 91 (231.0) 13.3 16.7 19.6

uranium U 92 238.03 13.6 17.2 20.2

neptunium Np 93 237.00 13.9 17.7 20.8

plutonium Pu 94 242.00 14.3 18.3 21.4

Table A-1. X-ray Emission Energies Arranged Alphabetically by Element, by Atomic Number

Element Symbol Atomic 
Number

Atomic 
Weight

Ka Kb La Lb Lg
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Appendix B: X-ray Emission Energies Arranged Alphabetically by Element, by 
name

Table A-2. X-ray Emission Energies Arranged Alphabetically by Element, by name

Element Symbol Atomic 
Number

Atomic 
Weight

Ka Kb La Lb Lg

actinium Ac 89 (226.0) 12.7 15.7 18.4

antimony Sb 51 121.76 26.3 29.9 3.6 3.8 4.3

arsenic As 33 74.92 10.5 11.7

astatine At 85 (210.0) 11.4 13.9 16.2

barium Ba 56 137.33 32.1 36.6 4.5 4.8 5.5

bismuth Bi 83 208.98 10.8 13.0 15.2

bromine Br 35 79.90 11.9 13.3

cadmium Cd 48 112.41 23.1 26.1 3.1 3.3 3.7

calcium Ca 20 40.80 3.7 4.0

cerium Ce 58 140.12 34.6 39.5 4.8 5.3 6.0

cesium Cs 55 132.91 30.9 35.1 4.3 4.6 5.3

chromium Cr 24 52.00 5.4 5.9

cobalt Co 27 58.93 6.9 7.6

copper Cu 29 63.55 8.0 8.9

dysprosium Dy 66 162.50 45.7 52.4 6.5 7.3 8.4

erbium Er 68 167.26 48.8 56.0 6.9 7.8 9.1

europium Eu 63 151.96 41.3 47.3 5.8 6.5 7.5

francium Fr 87 (223.0) 12.0 14.8 17.3

gadolinium Gd 64 157.25 42.8 48.9 6.1 6.7 7.8

gallium Ga 31 69.72 9.2 10.3

germanium Ge 32 72.59 9.9 11.0

gold Au 79 196.97 68.2 78.4 9.7 11.4 13.4

hafnium Hf 72 178.49 55.4 63.6 7.9 9.0 10.5

holmium Ho 67 164.93 47.3 54.2 6.7 7.5 8.7

indium In 49 114.82 24.1 27.4 3.3 3.5 3.9

iodine I 53 126.90 28.5 32.4 3.9 4.2 4.8

iridium Ir 77 192.20 64.3 73.9 9.2 10.7 12.5

iron Fe 26 55.85 6.4 7.1

krypton Kr 36 83.80 12.6 14.1

lanthanum La 57 138.91 33.3 38.0 4.7 5.0 5.8

lead Pb 82 207.19 74.2 85.4 10.5 12.6 14.8
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lutecium Lu 71 174.97 53.7 61.6 7.7 8.7 10.1

manganese Mn 25 54.94 5.9 6.5

mercury Hg 80 200.59 70.2 80.7 10.0 11.8 13.8

molybdenum Mo 42 95.94 17.4 19.6

neodymium Nd 60 144.24 37.2 42.5 5.2 5.7 6.6

neptunium Np 93 237.05 13.9 17.7 20.8

nickel Ni 28 58.70 7.5 8.3

niobium Nb 41 92.91 16.6 18.6

osmium Os 76 190.20 62.5 71.8 8.9 10.4 12.1

palladium Pd 46 106.42 21.1 23.9 2.8 3.0 3.3

platinum Pt 78 195.09 66.2 76.1 9.4 11.0 12.9

plutonium Pu 94 244.00 14.3 18.3 21.4

polonium Po 84 (209.0) 11.1 13.4 15.7

potassium K 19 39.10 3.3 3.7

praseodymium Pr 59 140.91 35.9 41.0 5.0 5.5 6.3

promethium Pm 61 (145.0) 38.5 44.0 5.4 6.0 6.9

protactinium Pa 91 231.0 13.3 16.7 19.6

radium Ra 88 (226.0) 12.3 15.2 17.8

radon Rn 86 (222.0) 11.7 14.3 16.8

rhenium Re 75 186.20 60.7 69.7 8.7 10.0 11.7

rhodium Rh 45 102.91 20.2 22.8 2.7 2.8 3.1

rubidium Rb 37 85.47 13.4 15.0

samarium Sm 62 150.35 39.9 45.6 5.6 6.2 7.2

scandium Sc 21 44.96 4.1 4.5

selenium Se 34 78.96 11.2 12.5

silver Ag 47 107.87 22.1 25.0 3.0 3.2 3.5

strontium Sr 38 87.62 14.1 15.8

tantalum Ta 7 180.95 57.1 65.6 8.1 9.3 10.9

tellurium Te 52 127.60 27.4 31.1 3.8 4.0 4.6

terbium Tb 65 158.92 44.2 50.7 6.3 7.0 8.1

thallium Tl 81 204.37 72.2 83.0 10.3 12.2 14.3

thorium Th 90 232.04 13.0 16.2 19.0

thulium Tm 69 168.93 50.4 57.8 7.2 8.1 9.4

Table A-2. X-ray Emission Energies Arranged Alphabetically by Element, by name

Element Symbol Atomic 
Number

Atomic 
Weight

Ka Kb La Lb Lg
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tin Sn 50 118.71 25.2 28.6 3.4 3.7 4.1

titanium Ti 22 47.90 4.5 4.9

tungsten W 74 183.85 58.9 67.6 8.4 9.7 11.3

uranium U 92 238.03 13.6 17.2 20.2

vanadium V 23 50.94 4.9 5.4

xenon Se 54 131.30 29.7 33.8 4.1 4.4 5.0

ytterbium Yb 70 173.04 52.0 59.7 7.4 8.4 9.8

yttrium Y 39 88.91 14.9 16.8

zinc Zn 30 65.38 8.6 9.6

zirconium Zr 40 91.22 15.7 17.7

Table A-2. X-ray Emission Energies Arranged Alphabetically by Element, by name

Element Symbol Atomic 
Number

Atomic 
Weight

Ka Kb La Lb Lg
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Appendix C: SpectraView

SpectraView enables you to qualitatively analyze the fluorescent x-rays of 
most of the elements in the periodic table in a given sample. For a complete 
list of elements and their fluorescent x-rays see Appendix A. In SpectraView 
Mode, the spectrum is displayed in a linear scale, autoscaled logarithmically 
so that the highest peak on the screen reaches the top of the scale.

How to Use SpectraView You can access the SpectraView screen after taking a measurement in any 
mode, or while viewing a previous measurement, by selecting Spectra from 
the NAV Menu. Once you are in SpectraView, you can use the up and down 
positions of the 4-way touch pad to scroll through the spectrum, or you can 
tap on the spectrum display with the stylus to place the cursor at the point 
you tapped. The vertical cursor line indicates the current position along the 
spectrum.

Viewing the Information
in SpectraView Mode

Figure A-1. The SpectraView Screen

By default, the following information is shown along with the spectrum:

The Reading number (Bottom Left) in the form "Read:x", where x is the 
Reading number.

Energy at 

NAV Menu

Vertical Slider

Spectrum Peaks

Reading Number

Horizontal Slider

Nearest Peaks

Count Rate

Cursor Position
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The position of the cursor on the energy scale (Bottom Left, under the 
Reading number), in the form "E: x.xx KeV", where KeV is thousands of 
electron volts.

The count rate (Bottom Left, under the energy position), in the form 
“R:x.xx”.

Ka, Kb, La, Lb, and/or Lg peaks of the three elements closest to where 
your cursor is positioned on the energy scale (Bottom Right). This 
information is written with the element symbol first, followed by either Ka 
(K shell alpha peak), Kb (K shell beta peak), La (L shell alpha peak), La (L 
shell beta peak), or Lg (L shell gamma peak). An example would be "Al Ka 
1.5." To determine if a given element is present, look at the count rate at 
that cursor position. 

SpectraView cannot be used to determine exact element percentages in a 
sample.

Multiple Spectra SpectraView can display the reading spectra from multiple sources if your 
analyzer has more than one X-ray source or filter. Use the NAV Menu to 
select which spectrum to view.

The “Spectra1” choice will display the display the spectrum produced by 
excitation from the first source.

The “Spectra2” choice will display the display the spectrum produced by 
excitation from the second source.

The “Spectra3” choice will display the display the spectrum produced by 
excitation from the third source.

SpectraView Navigation Use the left button on the 4-way touch pad to expand the spectrum, 
centered on the position of the cursor.

Use the right button on the 4-way touch pad to contract the spectrum, 
centered on the position of the cursor.
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Figure A-2. Viewing Multiple Spectra

Select NAV to access the
NAV Menu while viewing the
first source spectrum.

Select Spectra2 to view
the second source spectrum

Select NAV to access the
NAV Menu.

Select Spectra1 to return to 
the first source spectrum.
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Appendix D: Summary of Warnings

Warning! Do not attempt to use this instrument without first reading and 
understanding the entire User’s Guide! 

WARNING! Always be aware of the location of your instrument’s 
radioactive sources and the direction of their beam of X-rays. The location 
of the sources is at the front end of the instrument. 

WARNING! Always treat radiation with respect. Do not hold your 
instrument near the Kapton window during testing. Never point your 
instrument at yourself or anyone else when the shutter is open. 

WARNING! In the unlikely event that the shutter becomes stuck in the 
open position, remove the battery (see Battery Pack and Battery Charger - 
Routine Maintenance Guidelines - Note: All shutters should close 
immediately and remain locked in the closed position when the battery pack 
is not attached to the instrument), replace the instrument in its shielded 
holster, place the holster in the shielded carrying case, and call Thermo 
Scientific’s Service Department at (800) 875-1578 or +1-978-670-7460. 

WARNING! If your LCD Touch Screen displays the message ”SHUTTER 
DOES NOT OPERATE”, remove the battery (see Battery Pack and Battery 
Charger - Routine Maintenance Guidelines - Note: All shutters should close 
immediately and remain locked in the closed position when the battery pack 
is not attached to the instrument), replace the instrument in its shielded 
holster, place the holster in the shielded carrying case, and call Thermo 
Scientific’s Service Department at (800) 875-1578 or +1-978-670-7460. 

WARNING! The preconditions for operation must be continued for the 
duration of the reading. If the preconditions are violated, all the shutters will 
close, and the measurement will end. The three LED lights will stop 
blinking, the shutters will close, and the measurement will end. The flashing 
of the LED lights is not synchronized to minimize power consumption. 
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WARNING! The three LED warning lights are designed to blink only 
during a measurement, where one or more of the shutters are open and the 
trigger depressed. If the LED lights blink at any other time, disconnect the 
battery pack immediately, place the instrument in its shielded holster, place 
the holster in the shielded carrying case, and call Thermo Scientific’s Service 
Department in the United States, toll free, at (800) 875-1578, or outside 
the United States, at +1-978-670-7460, or your local Authorized NITON 
Analyzers Service Center. 

WARNING! When taking samples from a site where toxic chemicals may 
be present, always use gloves and respiration equipment for your own 
protection. 

WARNING! Do not hold bagged samples while testing. 

WARNING! Tampering with the 5,500 ppm (lead high) lead-in-soil 
standard may cause exposure to lead dust. Keep all standards out of the 
reach of children. 

WARNING! It is important that the date and time information displayed 
on the Date and Time Screen is correct. If either the date or time is 
incorrect, the information stored with your readings will be incorrect. In 
addition, an incorrect date prevents the instrument from properly 
compensating for normal source decay - causing erroneous analysis results 
for instruments equipped with 109Cd. This information must be correct 
before proceeding with testing. 

WARNING! Do not attempt to take measurements while downloading 
readings! This will generate an error requiring a system reset, and may 
corrupt your stored readings, requiring all stored readings to be erased. 

WARNING! Grinding and sifting dried samples produces dust. Even clean 
soil contains silica, which may be hazardous when airborne. Prepare all 
samples in a ventilated area; wear a mask, gloves, and an apron; and spread a 
drop cloth. 

WARNING! All Service, except exterior cleaning and Kapton window 
replacement, must be performed by Thermo Scientific. Do not attempt to 
make repairs yourself. Opening the case of your NITON will void the 
instrument Warranty in its entirety. 
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Appendix E: Summary of Cautions

CAUTION NITON Analyzers are not intrinsically safe instruments in 
regard to sparking. All pertinent Hot Work procedures should be followed 
in areas of concern. 

CAUTION Enabling the backlight will reduce your battery pack operating 
time, requiring more frequent recharges. 

CAUTION After being powered on, the NITON 300 Series Analyzer will 
perform an internal re-calibration before an analysis is initiated.  It is 
recommended that you let your instrument warm up for ten minutes after 
start up, before testing is begun. 

CAUTION Standard Thin Sample Mode should not be used for 
quantitative lead-paint testing. Use only the three Paint Testing modes to 
test lead-based paint, which are available only on certain models. 

CAUTION All test equipment must be kept clean to prevent 
contamination of samples. 

CAUTION Never tamper with Test Standards. They should not be used 
unless they are completely intact. 

CAUTION Your XLp analyzer must have the correct time and date set in 
order to test samples correctly using the 109Cd radioisotope source. Please 
make sure that the time and date are set correctly before testing. 

CAUTION Never turn off the instrument while data is being erased! 

CAUTION Do not leave the battery pack connected to the charger for 
excessive periods of time. Overnight recharging is recommended. 

CAUTION Store the instrument and the spare battery packs in a cool 
place, away from direct sunlight. 
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CAUTION Always obtain a Return Authorization (RA) number from 
Thermo Scientific’s Service Department in the United States, toll free, at 
(800) 875-1578, or outside the United States, at +1-978-670-7460 before 
returning your instrument to the NITON Service Department or local 
Authorized NITON Analyzer Service Center. 

CAUTION Do not force the charger into the RS-232 port!  

CAUTION Do not store battery packs or charger in direct sunlight. 

CAUTION Do not let the battery pack recharge for excessive periods of 
time.

CAUTION Always transport the unit in its padded carrying case, and store 
the NITON Analyzer in its case whenever it is not being used. 

CAUTION In most cases, no notification is required if transporting within 
state boundaries. This may not be the case when entering federal properties. 


CAUTION Within the United States, always keep a copy of the US DOT 
compliance statement in your NITON instrument case at all times. A copy 
is included with your instrument. 

CAUTION Always follow all pertinent local and national regulations and 
guidelines, wherever your XLp 300 series analyzer is transported or used. 

CAUTION If you return your NITON instrument without the carrying 
case, you will void your NITON 300 Series Analyzer's warranty in its 
entirety. You will be billed for a replacement case plus any repairs resulting 
from improper shipping. 

CAUTION Always remove the battery pack when transporting or storing 
your instrument. 

CAUTION Use of controls, adjustments or performance of procedures 
other than those specified herein may result in hazardous laser light 
exposure. 
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CAUTION Avoid any vibration, loud noise, strong electronice fields, or 
other possible interference when your analyzer is calibrating its detector. 
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Appendix F: Laser Device Notice

Thermo Scientific products using lasers comply with US 21CFR1040.10, 
Subchapter J, and with IEC825/EN 60 825 or IEC825-1/EN 60 825-1, 
depending on date of manufacture. The laser classification is marked on one 
of the labels on the product.

Class 1 laser devices are not considered to be hazardous when used for their 
intended purpose. The following statement is required to comply with IUS 
and International regulations:

CAUTION Use of controls, adjustments or performance of procedures 
other than those specified herein may result in hazardous laser light 
exposure. 

Class 2 laser scanners use a low power, visible light diode. As with any very 
bright light source, such as the sun. the user should avoid staring directly 
into the light beam. Momentary exposure to a Class 2 laser is not known to 
be harmful. 
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Appendix G: Warranty

Thermo Fisher Scientific will warranty parts and labor for any 
manufacturer’s defects for two years (24 months). No precision instrument 
is warranted if crushed, dropped on the floor or in a bucket of water. All 
service, including repairs and routine maintenance, and  x-ray tube 
replacement  or re-sourcing, must be performed by Thermo Fisher Scientific 
or by an Authorized NITON Analyzer Service Facility. Any attempt to open 
the sealed plastic housing of your NITON instrument will nullify the 
instrument warranty in its entirety. 

Limited Warranty Provision
for Use with Purchase and

License Agreement for Thermo
Fisher Scientific XRF Detection

instruments:

Except as otherwise agreed in writing, Thermo Fisher Scientific warrants, 
under normal conditions of operation, each product sold (except for 
components not of its manufacture) against defects of material and 
workmanship, provided that such product has been properly utilized. This 
warranty applies to the original purchaser only and shall commence to run 
from the date of shipment and shall continue for a period of twenty-four 
(24) months. In any event, Thermo Fisher’s liability for any such defects of 
material and workmanship shall not exceed the cost of replacement of 
defective parts upon timely notification of such defect in writing delivered 
to Thermo Fisher’s home office. Thermo Fisher shall not be liable for 
damage or destruction caused during delivery or caused other than by 
employees of Thermo Fisher Scientific. 

Material, accessories, parts, or items of equipment furnished by suppliers to 
Thermo Fisher and used in the manufacture of Thermo Fisher products are 
guaranteed by Thermo Fisher Scientific only to the extent of the original 
manufacturer’s express warranty to Thermo Fisher for a period not to exceed 
the warranty period described in paragraph (a) above and provided that the 
purchaser shall have notified Thermo Fisher so as to enable Thermo Fisher 
to avail itself of its rights under such original manufacturer’s express 
warranty. 

Specific warranties of
some common

accessories:

• Battery Charger 12 months 
• Batteries 12 months 
• Soil Grinder no warranty 
• Single-stage helium tank regulator 12 months 
• Two-stage helium tank regulator 12 months 
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Thermo Fisher Scientific shall, at its option, repair such defects or replace 
the parts or products found defective. All defective parts are to be returned, 
freight prepaid, immediately to Thermo Fisher for inspection and credit. 
Thermo Fisher will make no allowance for repairs or alterations made by the 
purchaser unless made with the advance written consent of Thermo Fisher.

Thermo Fisher Scientific assumes no liability for costs of disassembly of 
defective parts and equipment. Shipment by purchaser of all repairs and 
replacements under this warranty are F.O.B. Thermo Fisher Scientific’s 
factory or authorized service representative and method of shipment will be 
determined by Thermo Fisher. The purchaser will pay shipping costs and 
insurance in both directions of products, parts, or components shipped for 
warranty service hereunder. The purchaser will be responsible for risk of loss 
in both direction. Replaced parts or components will become the property 
of Thermo Fisher Scientific. Replacement parts or components may contain 
recycled, refurbished, or remanufactured parts equivalent to new parts and 
shall be warranted for the remainder of the original warranty period for the 
products. 

Thermo Fisher Scientific shall not be liable for delays, deprivation of use, or 
any other damages, direct or indirect, which may result to the purchaser 
because of defects in the product or because of the purchaser’s inability to 
operate it or use it to his satisfaction. Thermo Fisher Scientific will not be 
liable to anyone for special or consequential damages of any kind. Thermo 
Fisher neither assumes nor authorizes any person to assume for it, any other 
obligation or liability with respect to Thermo Fisher products. 

a. Except for the foregoing express warranty, there are no warranties, 
representations, or guarantees, express or implied, except as are 
expressly set forth herein. The foregoing warranty is the only 
warranty made by Thermo Fisher Scientific. Any implied warranty 
of merchantability or fitness for a particular purpose on this product 
is limited in duration to the one year (12 month) duration of this 
written warranty. Some countries, and some states within the United 
States, do not allow limitations on how long an implied warranty 
lasts or the exclusion of limitation of incidental or consequential 
damages so the above limitations or exclusions may not apply to 
you. This warranty gives you specific legal rights and you may also 
have other rights which vary from state to state and country to 
country. 
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